User's Guide to FYDP Viewers and DoDSPEAR

Timothy J. Graves, Project Leader
PREFACE

The Institute for Defense Analyses (IDA) prepared this document for the Office of the Director (Program Analysis and Evaluation), under a task entitled, “FYDP Related Studies.” The objective of the task was to “conduct studies to improve the existing FYDP related taxonomy of missions and infrastructure and to maintain and utilize previously developed models for FYDP related analyses.” Both of the tools described in this document were used to further that objective. This document provides a guide for users of the tools.

This work was reviewed within IDA by David A. Drake, Pamela W. Forsyth, and James L. Wilson.
## CONTENTS

1. Introduction ........................................................................................................... 1-1

2. FYDP Viewers ....................................................................................................... 2-1
   
   2.1 Getting Started ............................................................................................... 2-2
       2.1.1 Activating FYDP Viewers ................................................................. 2-2
       2.1.2 Changing FYDP Positions .............................................................. 2-2
       2.1.3 Exiting FYDP Viewers .................................................................. 2-3
       2.1.4 Choosing a FYDP Viewer ............................................................... 2-3

   2.2 FYDP Viewer .................................................................................................. 2-4
       2.2.1 Displaying Data for Criteria Selected ............................................ 2-5
       2.2.2 Display Options .............................................................................. 2-6
       2.2.3 Displaying All Years Data for a Single PE/RIC Combination .... 2-7
       2.2.4 Selecting Subsets of Data ............................................................... 2-7
       2.2.5 Selecting Services, Agencies, or Infrastructure Categories ...... 2-8
       2.2.6 Selecting Types of Resources ......................................................... 2-8
       2.2.7 Viewing Data for Other Years ......................................................... 2-9
       2.2.8 Saving Query Results to a File ....................................................... 2-9
       2.2.9 Creating Data Groups or Reports .................................................... 2-10
       2.2.10 Exiting the FYDP Viewer ............................................................. 2-11

2.3 Constant $ Viewer .............................................................................................. 2-12
   
   2.3.1 Displaying Data for Criteria Selected ................................................. 2-13
   2.3.2 Display Options ..................................................................................... 2-14
   2.3.3 Displaying All Years Data for a Single PE/RIC Combination .. 2-15
   2.3.4 Selecting Subsets of Data .................................................................. 2-16
   2.3.5 Selecting Services, Agencies, or Infrastructure Categories .... 2-16
   2.3.6 Selecting Types of Resources ............................................................. 2-17
   2.3.7 Viewing Data for Other Years ............................................................ 2-17
   2.3.8 Saving Query Results to a File .......................................................... 2-17
2.3.9 Creating Data Groups or Reports .................................. 2-18
2.3.10 Exiting the Constant $ Viewer .................................. 2-19

2.4 Procurement Viewer .................................................... 2-20
2.4.1 Selecting an Appropriation and Line Item ....................... 2-21
2.4.2 Displaying All Years Data for a Single Cost Category ......... 2-22
2.4.3 Saving Query Results to a File .................................. 2-23
2.4.4 Exiting the Procurement Viewer .................................. 2-24

2.5 R&D Annex Viewer ...................................................... 2-25
2.5.1 Changing the Order of the Data .................................. 2-25
2.5.2 Displaying Data in Then-Year or Constant Dollars ............. 2-26
2.5.3 Selecting Subsets of Data ........................................ 2-26
2.5.4 Displaying Data for a Single Budget Activity ................. 2-26
2.5.5 Selecting Services or Agencies .................................. 2-26
2.5.6 Display Options .................................................... 2-27
2.5.7 Viewing Data for Other Years .................................... 2-28
2.5.8 Saving Query Results to a File .................................. 2-28
2.5.9 Exiting the R&D Annex Viewer .................................. 2-28

2.6 DMC Definitions Viewer .............................................. 2-29
2.6.1 Selecting a DMC .................................................... 2-29
2.6.2 Displaying PEs in the Selected DMC ........................... 2-31
2.6.3 Printing a DMC Definition ....................................... 2-31
2.6.4 Exiting the DMC Definitions Viewer ............................ 2-32

2.7 PE Definitions Viewer ................................................. 2-33
2.7.1 Selecting a PE ..................................................... 2-34
2.7.2 Ordering the PE List .............................................. 2-34
2.7.3 Displaying a PE Definition ...................................... 2-34
2.7.4 Printing a PE Definition ......................................... 2-35
2.7.5 Exiting PE Definitions ........................................... 2-35

3. DoDSPEAR ................................................................. 3-1
3.1 Data Display Overview ............................................... 3-3
3.1.1 Historical Display ................................................. 3-3
3.1.2 Current Display ................................................... 3-4

vi
3.2 Using DoDSPEAR ................................................................. 3-7
  3.2.1 DoDSPEAR Menu Choices ............................................. 3-7
  3.2.2 Exiting DoDSPEAR ...................................................... 3-7
  3.2.3 Updating DoDSPEAR .................................................. 3-7
  3.2.4 The “Help” Menu ....................................................... 3-7
  3.2.5 The “Analyze” Menu ................................................... 3-8

3.3 Single PE ........................................................................... 3-9
  3.3.1 Entering the PE Number ................................................. 3-9
  3.3.2 Plotting a Current Display ............................................. 3-10
      3.3.2.1 Selecting Years to be Plotted .................................. 3-10
      3.3.2.2 Selecting Positions to be Plotted ............................. 3-10
      3.3.2.3 Plotting a Trend Line .......................................... 3-11
      3.3.2.4 Generating the Current Plot ............................... 3-12
      3.3.2.5 Viewing the Current Plot ................................... 3-12
      3.3.2.6 Minimizing, Expanding, and Closing the Plot ....... 3-14
      3.3.2.7 Changing the Display ......................................... 3-14
      3.3.2.8 Changing the Plot Characteristics (“Gallery,”
              “Style,” “Features,” and “Annotate” Menus) ........... 3-16
      3.3.2.9 Copying, Saving, Printing, and Exiting the Plot ...... 3-18
      3.3.2.10 Changing the View (“Percent of TOA” and
              “Redefine TOA”) ............................................. 3-20
      3.3.2.11 Displaying Data to the RIC and RAG Levels ......... 3-21
      3.3.2.12 Changing PEs Plotted ....................................... 3-24
  3.3.3 Plotting a Historical Display ........................................ 3-24
      3.3.3.1 Selecting Position-Year Combinations ................. 3-25
      3.3.3.2 Selecting Appropriated or Expended Data ............. 3-26
      3.3.3.3 Viewing the Historical Plot ................................ 3-26
      3.3.3.4 Minimizing, Expanding, and Closing the Plot ...... 3-27
      3.3.3.5 Changing the Plot Characteristics (“Gallery,”
              “Style,” “Features,” and “Annotate” Menus) .......... 3-28
      3.3.3.6 Copying, Saving, Printing, and Exiting the Plot .... 3-29
      3.3.3.7 Changing the View (“Percent of TOA” and
              “Redefine TOA”) ........................................... 3-32
3.3.3.8 Displaying Data to the RIC and RAG Levels .......... 3-33
3.3.3.9 Changing PEs Plotted ........................................ 3-36

3.4 Cross-Cut PEs ...................................................... 3-37
3.4.1 Selecting the Cross-Cut Category .......................... 3-37
3.4.2 Sorting, Printing, and Saving the PE List ............... 3-38
3.4.3 Selecting PEs to Analyze ...................................... 3-38
3.4.4 Cross-Cut PE Plot Display ..................................... 3-39

3.5 Analyze PEs in a DMC .............................................. 3-41
3.5.1 Selecting a DMC .................................................. 3-41
3.5.2 Showing All PEs Within the DMC ......................... 3-42
3.5.3 Sorting, Printing, and Saving the PE List ............... 3-42
3.5.4 Selecting PEs to Analyze After “Show All” ............. 3-42
3.5.5 Searching the DMC by Trend .................................. 3-43
3.5.6 Searching the DMC by Expended versus Appropriated .. 3-44
3.5.7 Searching the DMC by Appropriated versus Budgeted .... 3-45
3.5.8 Selecting PEs to Analyze After a Search ................. 3-46

3.6 Analyze DMC Data .................................................. 3-47
3.6.1 Sorting, Printing, and Saving the DMC List .......... 3-47
3.6.2 Selecting DMCs to Analyze ................................... 3-47
3.6.3 Finding the DoD Total Funding .............................. 3-48

3.7 Analyze PEs in an Infrastructure Category ................ 3-50
3.7.1 Selecting an IC .................................................. 3-50
3.7.2 Showing All PEs Within the DMC ......................... 3-50
3.7.3 Sorting, Printing, and Saving the PE List ............... 3-50
3.7.4 Selecting PEs to Analyze After “Show All” .......... 3-51
3.7.5 Searching the IC by Trend ................................... 3-51
3.7.6 Searching the IC by Expended versus Appropriated .. 3-53
3.7.7 Searching the IC by Appropriated versus Budgeted .... 3-54
3.7.8 Selecting PEs to Analyze After a Search ............... 3-55
3.8 Analyze Infrastructure Data........................................ 3-56
   3.8.1 Sorting, Printing, and Saving the IC List .............. 3-56
   3.8.2 Selecting ICs to Analyze .................................. 3-56
   3.8.3 Finding the DoD Total Funding ............................ 3-57
3.9 Analyze Infrastructure Categories in a DMC .................. 3-59
   3.9.1 Selecting a DMC ............................................. 3-59
   3.9.2 Selecting ICs Within the DMC ............................ 3-60
   3.9.3 Sorting, Printing, and Saving the IC List .............. 3-61
   3.9.4 Selecting ICs to Analyze .................................. 3-61
3.10 Analyze Services ............................................... 3-62
    3.10.1 Selecting a Service ...................................... 3-63
    3.10.2 Printing and Saving a Service List ..................... 3-63
Appendix: Technical Information ................................... A-1
FIGURES

2-1. FYDP Viewers Menu Bar ................................................. 2-2
2-2. Selecting the “File” Menu ............................................. 2-2
2-3. “Select Data Directory” Dialog Box ................................. 2-3
2-4. “Viewers” Menu ....................................................... 2-3
2-5. FYDP Viewer Opening Screen ......................................... 2-4
2-6. Displaying Data ......................................................... 2-5
2-7. “Display” Menu .......................................................... 2-6
2-8. Revised “Display” Menu ............................................... 2-6
2-9. Displaying a Selected Record ......................................... 2-7
2-10. Option Boxes ............................................................ 2-8
2-11. “Save to File” Dialog Box ............................................ 2-10
2-12. Initial “Report Selector” Dialog Box .............................. 2-10
2-13. Filled in “Report Selector” Dialog Box .......................... 2-11
2-15. Constant $ Viewer Opening Screen ............................... 2-12
2-16. Displaying Data ......................................................... 2-13
2-17. “Display” Menu ........................................................ 2-14
2-18. Revised “Display” Menu .............................................. 2-14
2-19. Displaying a Selected Record ...................................... 2-15
2-20. Option Boxes ............................................................ 2-16
2-21. “Save To File” Dialog Box .......................................... 2-18
2-22. Initial “Report Selector” Dialog Box ............................. 2-18
2-23. Filled in “Report Selector” Dialog Box ........................ 2-19
2-25. Procurement Viewer Opening Screen ............................. 2-20
2-26. Procurement Appropriations Drop-Down List .................. 2-21
2-27. Annex Item Drop-Down List ......................................... 2-21
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3-18. Example of Position-Year Combination</td>
<td>3-26</td>
</tr>
<tr>
<td>3-19. Historical Display for a Single PE</td>
<td>3-27</td>
</tr>
<tr>
<td>3-20. Chart Menu Bar</td>
<td>3-28</td>
</tr>
<tr>
<td>3-21. “Save As” Dialog Box</td>
<td>3-30</td>
</tr>
<tr>
<td>3-22. “Set Max Range” Dialog Boxes</td>
<td>3-33</td>
</tr>
<tr>
<td>3-23. “RAGs” Submenus</td>
<td>3-34</td>
</tr>
<tr>
<td>3-24. “Select Plot” Dialog Box</td>
<td>3-35</td>
</tr>
<tr>
<td>3-25. “Cross-Cut PEs” Submenu</td>
<td>3-37</td>
</tr>
<tr>
<td>3-26. “Child Development” PE List</td>
<td>3-38</td>
</tr>
<tr>
<td>3-27. “Program Elements” Menu</td>
<td>3-39</td>
</tr>
<tr>
<td>3-28. Historical Display for Cross-Cut PEs</td>
<td>3-40</td>
</tr>
<tr>
<td>3-29. “PEs in a DMC” Submenus</td>
<td>3-41</td>
</tr>
<tr>
<td></td>
<td>3-42</td>
</tr>
<tr>
<td>3-31. “Tactical Air Forces” PE List</td>
<td>3-43</td>
</tr>
<tr>
<td>3-32. “Search By” Submenu</td>
<td>3-43</td>
</tr>
<tr>
<td>3-33. “Trend” Dialog Box</td>
<td>3-44</td>
</tr>
<tr>
<td>3-34. “Expended vs. Appropriated” Percentage Difference Dialog Box</td>
<td>3-45</td>
</tr>
<tr>
<td>3-35. “Expended vs. Appropriated” Dollar Difference Dialog Box</td>
<td>3-45</td>
</tr>
<tr>
<td>3-36. “Appropriated vs. Budgeted” Percentage Difference Dialog Box</td>
<td>3-46</td>
</tr>
<tr>
<td>3-37. “Appropriated vs. Budgeted” Dollar Difference Dialog Box</td>
<td>3-46</td>
</tr>
<tr>
<td>3-38. “DMC Data” Submenu</td>
<td>3-47</td>
</tr>
<tr>
<td>3-39. “5-digit DMC” List</td>
<td>3-48</td>
</tr>
<tr>
<td>3-40. Revised “1-digit DMCs” Menu</td>
<td>3-49</td>
</tr>
<tr>
<td>3-41. “PEs in an Infrastructure” Submenu</td>
<td>3-50</td>
</tr>
<tr>
<td>3-42. “Force Management” PE List</td>
<td>3-51</td>
</tr>
<tr>
<td>3-43. “Search By” Submenu</td>
<td>3-52</td>
</tr>
<tr>
<td>3-44. “Trend” Dialog Box</td>
<td>3-52</td>
</tr>
<tr>
<td>3-45. “Expended vs. Appropriated” Percentage Difference Dialog Box</td>
<td>3-53</td>
</tr>
<tr>
<td>3-46. “Expended vs. Appropriated” Dollar Difference Dialog Box</td>
<td>3-53</td>
</tr>
<tr>
<td>3-47. “Appropriated vs. Budgeted” Percentage Difference Dialog Box</td>
<td>3-54</td>
</tr>
<tr>
<td>3-48. “Appropriated vs. Budgeted” Dollar Difference Dialog Box</td>
<td>3-54</td>
</tr>
</tbody>
</table>
3-49. “Infrastructure Data” Submenu ........................................... 3-56
3-50. “Infrastructure Subcategory” List ........................................ 3-57
3-51. “Mission/ICs” Menu ............................................................ 3-58
3-52. “ICs in a DMC” Submenus .................................................... 3-59
3-53. “Defense-Wide Missions” and “Defense-Wide Support Missions” Submenus ....................................................... 3-60
3-54. “ICs in a DMC” Dialog Box ..................................................... 3-60
3-55. “Tactical Air Forces” IC List ..................................................... 3-61
3-56. “Services” Selection ............................................................... 3-62
3-57. “Services” List ................................................................. 3-62
1. INTRODUCTION

This document describes the user actions required to effectively use two computer tools the Institute for Defense Analyses (IDA) developed for the Under Secretary of Defense (Acquisition and Technology) and the Office of the Director, Program Analysis and Evaluation.

The first tool provides the ability to view the contents of the Future-Years Defense Program (FYDP). This system has been labeled "FYDP Viewers." While not an analytical tool, FYDP Viewers is an aid to answering questions about the current or historical data contained in a single FYDP position.

The second tool is an analytical model to compare FYDP positions, find programs that are not performing as programmed, or evaluate shifts in funding between programs. This system is called DoDSPEAR for the Department of Defense Selective Program Element Analysis Report. This work is an outgrowth of an effort begun in the Air Force that IDA subsequently modified.

Each system description includes the data sources, information on data processing required to prepare the data for the model, and the user actions required to operate the models.

Both tools are designed to operate on a stand-alone PC. The preferred configuration is a 32-bit operating system, such as Microsoft Windows 95, and a high-resolution monitor. Both tools will work with older Microsoft Windows operating systems and lower resolution monitors, but speed and legibility will be sacrificed. Installation is accomplished using a CD or set of diskettes IDA provides.

The preferred setup for both tools is a network/server arrangement. The data for each model are in large dBase V databases. The databases should be stored on a network and the tool software installed on the user’s own machine. This arrangement facilitates updates of the data at the three annual releases of the FYDP. If security or network availability is an issue, everything can be installed on a single computer. Except for some definitions, all data are classified as Secret.
Chapter 2 of this document describes the FYDP Viewers tool, and Chapter 3 describes DoDSPEAR. The appendix provides technical details concerning file-naming conventions and the suggested directory structure for each model.
2. FYDP VIEWERS

FYDP Viewers consists of data and programs to display various components of the FYDP or FYPD-related data. The tool is installed from a series of diskettes or a CD and updated with new FYDP positions as OSD releases them. It consists of six different viewers, as follows:

- “FYDP” displays the DoD FYDP data from 1962 through the current FYDP period. Included are total obligational authority (TOA), forces, and personnel by Program Element (PE) and resource identification code (RIC). These are the lowest level of data elements in the FYDP.

- “Constant $” displays the FYDP TOA in the constant dollar appropriate for the particular FYDP position using deflators developed by the Under Secretary of Defense (Comptroller).

- “Procurement” displays Procurement Program data for each procurement appropriation and its line items. This display includes data from 1972 through the current FYDP period.

- “R&D Annex” displays the Research, Development, Test and Evaluation (RDT&E) Program data for each RDT&E appropriation. These data are from 1962 through the current FYDP period.

- “DPP” displays the Defense Program Projection (DPP) database. The DPP represents the FYDP from 1975 through the current FYDP period and extends that data for 12 years. Because these data are available only to selected personnel, the DPP Viewer is not discussed in detail in this paper.

- “Definitions” displays PE and Defense Mission Category (DMC) definitions.

The following sections describe each of these viewers and use computer screen pictures to explain the user actions required to activate the various displays. The first actions are activating the tool and selecting the appropriate data source.

More than one viewer can be open at the same time.
2.1 GETTING STARTED

2.1.1 Activating FYDP Viewers

To activate FYDP Viewers, run the executable file called ALLVIEWR.EXE. Use a method appropriate to your computer’s operating system. For example, on a system with Microsoft Windows 95, select Viewers from the Start Menu or double click a shortcut icon on the desktop. On a Windows 3.x system, double click ALLVIEWR.EXE in the file manager or double click on the icon in the Viewers Group. Figure 2-1 is the opening screen.

![Figure 2-1. FYDP Viewers Menu Bar](image)

The banner across the top of the screen shows the FYDP position and data directory that were selected the last time FYDP Viewers was closed. This information is stored in the file VIEWERS.INI in the VIEWERS directory. In this example, the selected FYDP position name was also used as the directory name. While this is not a requirement, it helps keep the data organized efficiently.

2.1.2 Changing FYDP Positions

To change directories and thus to change FYDP positions, select “File” from the drop-down menu in Figure 2-2 and select the “Change Data Directory” menu item.

![Figure 2-2. Selecting the “File” Menu](image)

After you select this menu item, the dialog box in Figure 2-3 appears. Select the drive and directory containing the desired data.
2.1.3 Exiting FYDP Viewers

To exit FYDP Viewers and return to Windows, select “Exit to Windows” from the “File” menu, shown in Figure 2-2.

2.1.4 Choosing a FYDP Viewer

Once you have selected the desired position, choose one of the six viewers from the “Viewers” menu in Figure 2-4. The following subsections describe each viewer in the order shown on this menu.

![Select Data Directory Dialog Box](image)

Figure 2-3. “Select Data Directory” Dialog Box

![Viewers Menu](image)

Figure 2-4. “Viewers” Menu
2.2 FYDP VIEWER

The FYDP viewer displays the FYDP data from 1962 through the end of the FYPD period plus 3 years, since force data is included for 3 years beyond the normal FYDP period. Total obligational authority (TOA) dollars are shown as “current” or “then-year” values as shown in the FYDP. TOA dollars, personnel quantities, and force quantities are shown by resource identification code (RIC).

The data are directly from the OD/PA&E FYDP data release as PE, RIC, year, and amount, and reformatted in dBase V to display all years of data for each PE and RIC combination. Additional information such as DMC, Infrastructure Code, PE titles, and RIC titles were added.

Figure 2-5 shows the data display format. In the example, no values have been entered in any of the entry boxes and the “ALL” option has been selected for all drop-down menus.

![Image of FYDP Viewer Opening Screen]

Figure 2-5. FYDP Viewer Opening Screen
*Unclassified Sample: For Training Purposes Only*
2.2.1 Displaying Data for Criteria Selected

Click the “Display Data” button in the lower right portion of the screen. Under the conditions selected in Figure 2-5, a query is run on the database to fill in the grid with all FYDP data. In the example shown in Figure 2-6, the box “Number of Records that Match Query” for these all-inclusive criteria shows the entire database of 28,175 records for the FY 1998 PB.

![Figure 2-6. Displaying Data](image)

**Unclassified Sample: For Training Purposes Only**

The size of the screen and the grid prevent the FYDP viewer from showing more than a 6-year span of values. Since the column in the grid that shows the PE Title is too narrow, the box at the bottom left shows the full PE title for the selected record. In this case, “B-47 Squadrons (H)” is in the title box.
2.2.2 Display Options

Figure 2-7 shows the “Display” menu items. They are as follows:

- “4 years”—changes the display from six years to four years of data. When the data values are too large to fit in the space provided for each year column, select “4 Years” and the data display area reduces to four wider columns. At the same time, the menu item changes to “6 Years.” If you select “6 Years,” the display returns to six columns.

- “FY98 PB Records”—represents the currently selected position. When you select this menu item, the data query is reaccomplished and the grid changes to show only those records that have a non-zero value for at least one year during the FYDP period. For example, with the FY 1998 PB selected, only those records with at least one non-zero value between FY 1998 and FY 2006 will be displayed. Simultaneously, the menu item caption changes to “All Records.” Select this menu item to display all records. The revised menu is shown in Figure 2-8.

- “Data”—performs the same function as the “Display Data” button (explained in the previous subsection).

- “Detail”—displays the span of data for a single record (explained in the next subsection).

![Figure 2-7. “Display” Menu](image)

![Figure 2-8. Revised “Display” Menu](image)

Shortcut keys for most of the menu items appear on the right of the menu.
2.2.3 Displaying All Years Data for a Single PE/RIC Combination

Select a particular PE/RIC combination (a single database record) and then select "Detail" from the "Display" menu shown in Figure 2-7. The entire span of data for that single record is displayed in a separate window as Figure 2-9 shows.

![Figure 2-9. Displaying a Selected Record](image)

*Unclassified Sample: For Training Purposes Only*

To print the "Selected Record" window, click the "Print" button. To return to the underlying screen, click the "Exit" button. The "Selected Record" window is common to all the views that present numeric data.

2.2.4 Selecting Subsets of Data

Figure 2-10 shows the detail of the available option boxes. If the data you want to select is for a single PE, enter all or part of the PE into the appropriate box then click the "Display Data" button. For example, if you wish to see all PEs that begin with "0207," enter that number in the box for PE number. Likewise, if you want all the data for a
DMC, enter all or part of the DMC. In this manner, you can display the data for multiple PEs and multiple services.

![Figure 2-10. Option Boxes](image)

2.2.5 Selecting Services, Agencies, or Infrastructure Categories

The “Service” and “Infra. Category” boxes have drop-down lists. The list for “Service” is shown at left. If you want to see all the data for the Marine Corps, for example, use the “Service” box to select USMC and leave the DMC and PE boxes empty. You can scroll through each service and agency on the list. If you want to see data for just the military departments, select “All Services.” Conversely, Pick “All Agencies” to see data for defense agencies only.

The “Infra. Category” drop-down list displays the complete list of infrastructure categories. You can select the item of interest.

2.2.6 Selecting Types of Resources

You may want to limit your search to some particular type of resource. Use the “Category” drop-down list under “Resource Type,” shown at left, to select “All,” “Personnel,” “$(M)” (dollar), or “Forces” records for display. Once you’ve made a selection, only those types of resources will be displayed.

2-8
To further restrict the display, select a subcategory. Shown below are the choices for subcategories when the categories “$M(M)” and “Personnel” are chosen.

When resources of a single type, “$M(M)” or “Personnel,” are selected, the subtotal for the chosen records is displayed on the grid. No subtotals are displayed when you select either “All” or “Forces.”

2.2.7 Viewing Data for Other Years

As can be seen in Figure 2-6, scroll bars are available on both the vertical and horizontal portions of the display area. Using standard Microsoft Windows mouse operations, you can scroll left to any year back to FY 1962 or right to the FYDP end year plus three years. You can scroll vertically to see all data records that met the search criteria.

2.2.8 Saving Query Results to a File

Search results can be saved to a file. The saved file is a tab-delimited text file that can be imported into Microsoft Excel or other software. Under the file menu, select “Save To File,” as shown at left. The dialog box in Figure 2-11 appears. Select the directory to which you want to save the file and enter a name for the saved file.
2.2.9 Creating Data Groups or Reports

The “Report” menu item is unavailable until a query for a single resource type has been completed. When selected, the dialog box shown in Figure 2-12 appears. By making the appropriate selections, you can have the program perform basic “roll-up” functions.

In the example shown, the query was to display all dollar records for PEs that begin with “0207.”

Figure 2-13 shows the request to group the results first by 6-digit DMC, then by the first 7 digits of the PE for the years 1990 through 1998. When the “Report” menu item is selected, the menu shown in Figure 2-14 is available.
To display the results of the roll-up on the screen, select “View” or press <Ctrl><V>. The results can also be printed or written to a file.

To close the window, click “Cancel.”

2.2.10 Exiting the FYDP Viewer

To close the FYDP viewer, select “Exit” on the “File” menu or press <Ctrl><X>.
2.3 CONSTANT $ VIEWER

The features of the Constant $ viewer are identical to those of the FYDP viewer. The difference is that only dollar records are available, and they are all in the appropriate constant dollar base year. The constant dollar base year used for the selected FYDP position is displayed in the upper right corner of the display format in Figure 2-15. The FYDP TOA data are converted from then-year dollars to constant dollars using the Comptroller published deflators.

Figure 2-15. Constant $ Viewer Opening Screen

The only difference from the FYDP viewer format is that the “Resource Type” drop-down list is replaced with a single “Category” drop-down list. This is the same as the “$ (M)” subcategory of the FYDP viewer.

In the example, no values have been entered in any of the entry boxes and the “ALL” option has been selected for all drop-down menus.
2.3.1 Displaying Data for Criteria Selected

Click the “Display Data” button in the lower right portion of the screen. Under the conditions selected in Figure 2-15, a query is run to fill the grid with data. In the example shown in Figure 2-16, the box “Number of Records that Match Query” for these all-inclusive criteria shows the entire database of 12,221 records for the FY 1998 PB.

![Figure 2-16. Displaying Data](Image)

Unclassified Sample: For Training Purposes Only

The size of the screen and the grid prevent the Constant $ viewer from showing more than a 6-year span of values. Since the column in the grid that shows PE Title is too narrow, the box at the bottom left shows the full title of the Program Element of the selected record. In this case, “B-47 Squadrons (H)” is in the title box.
2.3.2 Display Options

Figure 2-17 shows the “Display” menu items. They are as follows:

- “4 years”—changes the display from six years to four years of data. When the
data values are too large to fit in the space provided for each year column,
select “4 Years” and the data display area reduces to four wider columns. At
the same time, the menu item changes to “6 Years.” If you select “6 Years,”
the display returns to six columns.

- “FY98 PB Records”—represents the currently selected position. When this
menu item is selected, the data query is reaccomplished and the grid changes
to show only those records that have a non-zero value for at least one year
during the FYDP period. For example, with the FY 1998 PB selected, only
those records with at least one non-zero value between FY 1998 and FY2006
will be displayed. Simultaneously, the menu item caption changes to “All
Records.” Select this menu item to display all records. The revised menu is
shown in Figure 2-18.

- “Data”—performs the same function as the “Display Data” button (explained
in the previous subsection).

- “Detail”—displays the span of data for a single record (explained in the next
subsection).

Figure 2-17. “Display” Menu

![Display Menu](image)

Figure 2-18. Revised “Display” Menu

![Revised Display Menu](image)

Shortcut keys for most of the menu items appear on the right of the menu.
2.3.3 Displaying All Years Data for a Single PE/RIC Combination

Select a particular PE/RIC combination (a single database record) and then select “Detail” from the “Display” menu as shown in Figure 2-17. The entire span of data for that single record is displayed in a separate window as Figure 2-19 shows.

![Figure 2-19. Displaying a Selected Record](Image)

*Unclassified Sample: For Training Purposes Only*

To print the “Selected Record” window, click the “Print” button. To return to the underlying screen, click the “Exit” button. The “Selected Record” window is common to all the views that present numeric data.
2.3.4 Selecting Subsets of Data

Figure 2-20 shows the detail of the available option boxes. If the data you want to select is for a single PE, enter all or part of the PE into the appropriate box then click the “Display Data” button. For example, if you wish to see all PEs that begin with “0207,” that is all you need to enter. Likewise, if you want all the data for a DMC, enter all or part of the DMC. In this manner, you can display the data for multiple PEs and multiple services.

![Constant $ Database Query](image)

**Figure 2-20. Option Boxes**

2.3.5 Selecting Services, Agencies, or Infrastructure Categories

The “Service” and “Infra. Category” boxes have drop-down lists. The list for “Service” is shown at left. If you want to see all the data for the Marine Corps, for example, use the “Service” box to select USMC and leave the DMC and PE boxes empty. You can scroll through each service and agency on the list. If you want to see data for just the military departments, select “All Services.” Conversely, Pick “All Agencies” to see data for defense agencies only.

The “Infra. Category” drop-down list displays the complete list of infrastructure categories. You can select the item of interest.
2.3.6 Selecting Types of Resources

You may want to limit your search to some particular category of constant dollar resource. Use the “Category” drop-down list under “Resource Type,” shown at left, to select “All,” “RDT&E,” “MilCon,” “Procurement,” or “Operations” records for display. Once you’ve made a selection, only those types of resources will be displayed. The subtotal for the chosen records is displayed on the grid.

2.3.7 Viewing Data for Other Years

As can be seen in Figure 2-16, scroll bars are available on both the vertical and horizontal portions of the display area. Using standard Microsoft Windows mouse operations, you can scroll left to any year back to FY 1962 or right to the FYDP end year plus 3 years. You can scroll vertically to see all data records that meet the search criteria.

2.3.8 Saving Query Results to a File

Search results can be saved to a file. The saved file is a tab-delimited text file that can be imported into Microsoft Excel or other software. Under the file menu, select “Save To File,” as shown at left. The dialog box in Figure 2-21 appears. Select the directory to which you want to save the file and enter a name for the saved file.
2.3.9 Creating Data Groups or Reports

The “Report” menu item is unavailable until a query has been completed. When selected, the dialog box shown in Figure 2-22 appears. By making the appropriate selections, you can have the program perform basic “roll-up” functions.

In the example shown, the query was to display all dollar records for PEs that begin with “0207.”

Figure 2-23 shows the request to group the results first by 6-digit DMC, then by the first 7 digits of the PE for the years 1990 through 1998. When the “Report” menu item is selected, the menu shown in Figure 2-24 is available.
To display the results of the roll-up on the screen, select “View” or press <Ctrl><V>. The results can also be printed or written to a file.

To close the window, click “Cancel.”

2.3.10 Exiting the Constant $ Viewer

To close the Constant $ viewer, select “Exit” on the “File” menu or press <Ctrl><X>.
2.4 PROCUREMENT VIEWER

The Procurement viewer displays the data from the Procurement Annex to the FYDP for all available years. The annex contains data for FY 1972 and prior, year-by-year data through the FYDP period, and a "to complete" entry for ongoing procurements. The Procurement viewer shows the FY 1972 and prior total in the FY72 field and year-by-year values from FY73 on. The "to complete" value is shown only for then-year funding and quantities, when available. The "to complete" values are shown only on the detail view explained in subsection 2.4.2.

The display screen is shown in Figure 2-25. The Procurement viewer data are prepared directly from data provided by the Comptroller. Constant dollar values are calculated using Comptroller-published deflators.

Figure 2-25. Procurement Viewer Opening Screen
2.4.1 Selecting an Appropriation and Line Item

Select an appropriation from the drop-down list of all procurement appropriations in Figure 2-26.

![Figure 2-26. Procurement Appropriations Drop-Down List](image)

Once the appropriation is selected, a drop-down list of all line items in that appropriation appears as shown in Figure 2-27 for Appropriation 1506, Aircraft Procurement - Navy. To sort the list either by Procurement Annex Line Item (PALI) or by title, select the desired radio button under the “Order Annex Items by:” heading.

![Figure 2-27. Annex Item Drop-Down List](image)

After you select a line item, the data for that system are displayed in the grid. The data may be in either then-year or constant dollars; select the appropriate radio button under the “Funding: (Millions)” heading. Selecting the radio button causes the data display to change. It is easy to see the difference between then-year and constant dollar values for a particular year by alternately selecting one then the other radio button.

Figure 2-28 shows the grid after the AV-8A line item is selected for display.
For this procurement program, each cost category is as it appears in the Procurement Annex. Navy Shipbuilding has additional cost categories that use the entire grid. Notice that the last line represents quantities when that information is available. The Item Cost Total is a summation of the cost lines only. The Appropriation Total is the sum for this appropriation.

2.4.2 Displaying All Years Data for a Single Cost Category

To show detail of a particular record, select “Detail” from the “Display” menu. This is analogous to the “Detail” menu item in the FYDP and Constant $ viewers. The results of selecting “Detail” are shown in Figure 2-29.
Figure 2-29. Displaying a Selected Record
Unclassified Sample: For Training Purposes Only

Notice that the first entry is for FY 1972 and prior. If appropriate, an entry for “To Complete” is shown below the last entry.

2.4.3 Saving Query Results to a File

Search results can be saved to a file. The saved file is a tab-delimited text file that can be imported into Microsoft Excel or other software. Under the “File” menu, select “Save To File,” as shown at left. A dialog box appears from which you select the directory to which you want to save the file and enter a name for the saved file.
2.4.4 Exiting the Procurement Viewer

To close the Procurement viewer, select “Exit” on the “File” menu or press <Ctrl><X>.
2.5 R&D ANNEX VIEWER

The R&D Annex viewer displays data from the RDT&E Program of the FYDP. It is similar in appearance to the FYDP and Constant $ viewers, as can be seen in Figure 2-30. The data are taken directly from the Comptroller-provided RDT&E Program data.

![R&D Database Query](image)

Figure 2-30. R&D Viewer Opening Screen

Unclassified Sample: For Training Opening Purposes Only

2.5.1 Changing the Order of the Data

To display the data by Budget Activity (BA) or by PE, select the appropriate radio button under the “Order by” heading. Note: the BA structure changed in FY 1993; therefore, the drop-down list has two distinct portions one for “Pre-93” and the other for “Post-92.”
2.5.2 Displaying Data in Then-Year or Constant Dollars

To display the data in either then-year (TY) or constant dollar values, select the appropriate radio button under the “Select $ (M)” heading shown at left.

2.5.3 Selecting Subsets of Data

Figure 2-30 shows the available option boxes. If the data you want to select is for a single PE, enter all or part of the PE into the appropriate box then click the “Display Data” button. For example, if you wish to see all PEs that begin with “0207,” enter that number in the box for PE number. Likewise, if you want all the data for a DMC, enter all or part of the DMC. In this manner, you can display the data for multiple PEs and multiple services.

2.5.4 Displaying Data for a Single Budget Activity

Figure 2-31 shows the drop-down list for selecting a single Budget Activity (BA) for display. Note: The BA structure changed in FY 1993; therefore, the drop-down list has two distinct portions one for “Pre-93” and the other for “Post-92.”

![Figure 2-31. Selecting a Single Budget Activity](image)

2.5.5 Selecting Services or Agencies

The drop-down list for “Service” is shown here. If you want to see all the data for the Marine Corps, for example, use the “Service” box to select USMC and leave the DMC and PE boxes empty. You can scroll through each service and agency on the drop-down list. If you want to see data for just the military departments, select “All Services.” Pick “All Agencies” to see data for defense agencies only.
2.5.6 Display Options

Figure 2-32 shows the “Display” menu. They are as follows:

- “4 years”—changes the display from six years to four years of data. When the data values are too large to fit in the space provided for each year column, select “4 Years” and the data display area reduces to four wider columns. At the same time, the menu item changes to “6 Years.” If you select “6 Years,” the display returns to six columns.

- “FY98 PB Records”—represents the currently selected position. When this menu item is selected, the data query is reaccomplished and the grid changes to show only those records that have a non-zero value for at least one year during the FYDP period. For example, with the FY 1998 PB selected, only those records with at least one non-zero value between FY 1998 and FY 2006 will be displayed. Simultaneously, the menu item caption changes to “All Records.” Select this menu item to display all records. The revised menu is shown in Figure 2-33.

- “Data”—performs the same function as the “Display Data” button (explained in subsection 2.5.3).

- “Detail”—displays the span of data for a single record.

![Figure 2-32. “Display” Menu](image1)

![Figure 2-33. Revised “Display” Menu](image2)

Shortcut keys for most of the menu items appear on the right of the menu.

2-27
2.5.7 Viewing Data for Other Years

As can be seen in Figure 2-30, scroll bars are available on both the vertical and horizontal portions of the display area. Using standard Microsoft Windows mouse operations, you can scroll left to any year back to FY1962 or right to the FYDP end year. You can scroll vertically to see all data records that met the search criteria.

2.5.8 Saving Query Results to a File

Search results can be saved to a file. The saved file is a tab-delimited text file that can be imported into Microsoft Excel or other software. Under the file menu, select “Save To File,” as shown at left. From the dialog box that appears, select the directory to which you want to save the file and enter a name for the saved file.

2.5.9 Exiting the R&D Annex Viewer

To close the R&D Annex viewer, select “Exit” on the “File” menu or press <Ctrl><X>.
2.6 DMC DEFINITIONS VIEWER

The FYDP Viewers tool makes available the definitions of individual PEs and DMCs. Figure 2-34 shows the submenu on the “Viewers” menu you use to select the type of definition to be viewed.

![Figure 2-34. “Definitions” Submenu: DMC](image)

When you select “DMC,” the screen in Figure 2-35 is presented.

![Figure 2-35. DMC Definition Screen](image)

2.6.1 Selecting a DMC

To refine the search for a particular definition, select subsets of possible DMCs. Use the three drop-down lists below the words “DMC Viewer.” When the “One Digit”
DMC is selected, only the appropriate "Two Digits" are available. When that selection is made, only the appropriate "Three Digit" DMCs are shown. See Figure 2-36.

Figure 2-36. Selecting a DMC

Figure 2-37 shows how you would select DMC 2221. To display the definition once the choice of DMC is made, double click either the DMC number or DMC title.

Figure 2-37. Displaying a DMC Definition
2.6.2 Displaying PEs in the Selected DMC

Note in Figure 2-37 that when the definition is displayed, the button is highlighted. Click this button to display a list of all the PEs included in the selected DMC. Figure 2-38 is an example.

![Figure 2-38. PE List for Selected DMC](image)

2.6.3 Printing a DMC Definition

To change the font and font size to be used, select “Printer” under the “Options” menu. The dialog box at left appears. Select the font and font size from among those available on your default printer.
To send the definition to the default printer, select “Print Definition” on the “Form” menu.

2.6.4 Exiting the DMC Definitions Viewer

To exit the DMC Definitions viewer, select “Exit” from the “Form” menu or press <Ctrl><X>.
2.7 PE DEFINITIONS VIEWER

The FYDP Viewers tool makes available the definitions of individual Program Elements (PE) and Defense Mission Categories (DMC). Figure 2-39 shows the submenu of the “Viewers” menu used to select the type of definition to be viewed.

![Figure 2-39. “Definitions” Submenu: PE](image)

When you select “PE,” the screen in Figure 2-40 is presented.

![Figure 2-40. PE Definition Screen](image)
2.7.1 Selecting a PE

Use the scroll bars to move through the entire list of PEs until you find the desired PE. Alternatively, use the “MFP” (Major Force Program) or “Service” drop-down lists to limit the PE list to just those in the selected MFP or Service. See Figure 2-41

![Figure 2-41. Limiting the PE List by MFP or Service](image)

2.7.2 Ordering the PE List

To change the order of the PEs on the list, use the “Order By” radio buttons. You can sort the list either by PE number or by PE title.

2.7.3 Displaying a PE Definition

To display the desired PE definition, scroll to the desired PE number and double click on either the number or the title. Figure 2-42 shows the definition displayed.
2.7.4 Printing a PE Definition

To change the font and font size to be used, select “Printer” under the “Options” menu. The dialog box at left appears. Select the font and font size from among those available on your default printer.

To send the definition to the default printer, select “Print Definition” on the “Form” menu.

2.7.5 Exiting PE Definitions

To exit the PE Definitions viewer, select “Exit” from the “Form” menu or press <Ctrl><X>.
3. DODSPEAR

DoDSPEAR is an outgrowth of a model the Air Force developed using Microsoft Excel. IDA updated the model to Visual Basic using just Air Force data. At the request of OSD, the model was enlarged to display information for all of DoD.

The purpose of the model is to simultaneously display, both in graphic and tabular form, data for a particular Program Element (PE), Defense Mission Category (DMC), or Infrastructure Code (IC) from multiple FYDP positions. These forms of display enable you to discern trends in the data. It is both interesting and valuable for FYDP programmers to known when a funding value changed. Was the change in the Program Objectives Memorandum (POM) review, the Budget Estimate Submission (BES) review, the congressional review of the President's Budget (PB), or, finally, the obligation of funds during the execution phase of the budget?

Other uses of DoDSPEAR are to see the migration of funding from one appropriation to another over time or to find paired programs where one is increasing and the other is decreasing correspondingly.

The data for the model are taken from each FYDP position from the FY 1982 President's Budget to date. Note that some normal positions were not produced and there were no FYDP positions in FY 1989, the second year of the first biennial budgeting process. In addition, the model shows the values appropriated by the congress and the values obligated or expended. These terms are defined in the next subsection.

IDA wrote several preprocessor programs to take the normal FYDP data (PE, RIC, year, and amount) provided by OD/PA&E and manipulate them into the files necessary for DoDSPEAR. All dollar data are in then-year total obligational authority (TOA). There are no constant dollar amounts or adjustment amounts for changes in accounting rules over time. All force and personnel data are included. All values are those that existed in the selected FYDP position. While forces and personnel are not “appropriated” or “expended,” the force and personnel data represent the approved or historical quantities represented in those FYDP positions.

Remember that inflation assumptions change yearly and that predicted future budget amounts are often a matter of political policy. For example, the FY 1989 data in
the FY 1986 budget predicted nearly $500 billion for the DoD budget, an amount that clearly was never achieved. Future enhancements to DoDSPEAR include converting all data to constant dollars to enhance trend analyses.

DoDSPEAR is a rich source of data presented in a variety of ways; however, you must be careful that you understand the information being presented in each view.

Section 3.1 provides an overview of the two display methods available in DoDSPEAR. Understanding the differences in the display types is important to using the model correctly. Section 3.2 provides instructions on opening DoDSPEAR and details the initial menu choices. Sections 3.3 through 3.10 provide information on each of the eight options within DoDSPEAR for viewing FYDP data.

Because each of the eight methods of analysis present the same two data displays, the displays are explained in detail only once in Sections 3.3.2 and 3.3.3. You should review those two sections no matter which of the eight analysis methods you choose.

Since several of the analysis methods use the same series of dialog boxes to lead the user to the final display, there is some repetition in this guide. This is done purposely to make each section on a separate analysis method stand alone.
3.1 DATA DISPLAY OVERVIEW

Data are displayed in two different ways using the DoDSPEAR, the “historical” and the “current” displays.

3.1.1 Historical Display

In this display format, the data for the POM, BES, and PB are shown for the period of years that constituted the position. It is used to see how a program changes within a given position or in successive positions.

For example, the FY 1998 POM contained 6 years of data for FY 1998 through FY 2003. The FY 1999 POM, on the other hand, contained only 5 years of data for FY 1999 through FY 2003. Thus, the graph displayed will contain a line of 6 years in length for the FY 1998 POM and a line of 5 years in length for the FY 1999 POM.

The same is true for the BES and PB. The display lines will be 5 or 6 years in length, as appropriate.

Figure 3-1 is an example of the historical display. This chart is based upon the FY 1998 PB being the latest PB position. Note that the line and columnar data for the PB 1998 position show six values. The expended data are from the beginning of the plot to FY 1996, the latest expended data drawn from the FY 1998 PB. The appropriated data are from the beginning of the plot to FY 1997, the latest appropriated data also drawn from the FY 1998 PB. The 1994 POM data show the 6 years that constituted the FYDP years when the 1994 POM was current.

![Figure 3-1. Historical Display](image)

<table>
<thead>
<tr>
<th>Year</th>
<th>POM 1994</th>
<th>BES 1994</th>
<th>PB 1998</th>
<th>Expended</th>
<th>Appropriated</th>
</tr>
</thead>
<tbody>
<tr>
<td>1993</td>
<td>583.233</td>
<td>583.156</td>
<td>583.156</td>
<td>583.233</td>
<td>583.233</td>
</tr>
<tr>
<td>1994</td>
<td>583.233</td>
<td>583.156</td>
<td>583.156</td>
<td>583.233</td>
<td>583.233</td>
</tr>
<tr>
<td>1995</td>
<td>583.233</td>
<td>583.156</td>
<td>583.156</td>
<td>583.233</td>
<td>583.233</td>
</tr>
<tr>
<td>1996</td>
<td>583.233</td>
<td>583.156</td>
<td>583.156</td>
<td>583.233</td>
<td>583.233</td>
</tr>
<tr>
<td>1997</td>
<td>583.233</td>
<td>583.156</td>
<td>583.156</td>
<td>583.233</td>
<td>583.233</td>
</tr>
<tr>
<td>1998</td>
<td>583.233</td>
<td>583.156</td>
<td>583.156</td>
<td>583.233</td>
<td>583.233</td>
</tr>
<tr>
<td>1999</td>
<td>583.233</td>
<td>583.156</td>
<td>583.156</td>
<td>583.233</td>
<td>583.233</td>
</tr>
<tr>
<td>2000</td>
<td>583.233</td>
<td>583.156</td>
<td>583.156</td>
<td>583.233</td>
<td>583.233</td>
</tr>
<tr>
<td>2001</td>
<td>583.233</td>
<td>583.156</td>
<td>583.156</td>
<td>583.233</td>
<td>583.233</td>
</tr>
<tr>
<td>2002</td>
<td>583.233</td>
<td>583.156</td>
<td>583.156</td>
<td>583.233</td>
<td>583.233</td>
</tr>
<tr>
<td>2003</td>
<td>583.233</td>
<td>583.156</td>
<td>583.156</td>
<td>583.233</td>
<td>583.233</td>
</tr>
</tbody>
</table>
Recall that before FY 1988, all positions were 5 years in length—FYDP was the acronym for Five-Year Defense Program—and then the biennial budgeting process was introduced. Except for FY 1989, when there were no POM, BES, or PB positions, the DoD did not strictly follow the biennial rule and there were multiple FYDP positions in subsequent years. The POM, however, was not produced in every year following FY 1989. In some years, due usually to presidential elections, FYDP positions were skipped, duplicated, or combined. For example, both Presidents Bush and Clinton produced FY 1994 PBs, although the Clinton PB was only one year in length. Within DoDSPEAR, you can select which of these two PB positions to view. The same is true for the Reagan and Bush PBs of 1990.

In this historical display, appropriated data are shown as a continuous line from the first year selected up to the year before the first year of the most recent President’s Budget. These data are generated from each successive PB as the year before the first year of the PB FYDP and are available beginning with FY 1981. When any PB is published, the congressional actions are complete on the prior PB and the year prior data reflect the action of the Congress on that year. For example, the FY 1997 year of the FY 1998 PB reflects the congressional action on the first year of the FY 1997 PB.

The historical display of expended data reflects data taken from the latest PB for years prior to the year that represents appropriated data. Thus, for the FY 1998 PB, FY 1997 represents appropriated information, and all years from FY 1975 through FY 1996 reflect actual expenditures or obligations. For simplicity, the DoDSPEAR model uses the terms expended and obligated interchangeably. During data preprocessing, the expended data are updated, if necessary, back to FY 1975 with each successive PB. Expended data may change up to 8 years after the enactment of the Appropriation Bill due to reprogramming and normal procedures in obligating appropriated funds.

3.1.2 Current Display

In this form of display, the POM, BES, and PB are shown as individual, continuous lines, not lines representing periods of just 5 or 6 years. The points on these lines represent the connection of the first year points of successive like positions on the historical display. This view of the data shows how programs change from like position to like position without showing how they change within a position.

Figure 3-2 is an example of the current display. For example, the PB represents the first year of each successive PB. If the FY 1998 PB is the latest available PB and a
plot is made using PB data from FY 1990 onward, the value for FY 1990 represents FY 1990 of the FY 1990 PB, the value for FY 1996 represents FY 1996 of the FY 1996 PB, and so on. When the latest available PB position is reached (in this case, the FY 1998 PB), the value for FY 1998 represents FY 1998 of the FY 1998 PB, the value for FY 1999 represents FY 1999 of the FY 1998 PB, and so on, to the end of the current PB (in this case, FY 2003).

![Graph showing budget over years](image)

**Figure 3-2. Current Display**

The POM and BES data are generated in the same manner. Note in the figure that there are no data for the POM or BES in 1993. No separately identified POM or BES FYDP were produced for FY 1993, the year chosen as the first year to plot. Similarly, when there are other null column spaces in this display, it is because that position was not produced in that year. If FY 1992 had been chosen as the first year for the plot, the FY 1993 values would be shown. Those values would be the FY 1993 year of the FY 1992 POM or BES.

An exception to this rule applies for POM positions. For several years in the early 1990s, the DoD produced a POM FYDP only every other year. In these cases, the first two years of the POM position are used to represent the given years. For example, there was no FY 1991 POM. The value shown on the POM line for FY 1991 is the FY 1991 value from the FY 1990 POM FYDP.

In the current display, appropriated data are shown as a continuous line from the first year selected up to the year before the first year of the most recent President’s Budget. These data are generated from each successive PB as the year before the first year

3-5
of the PB FYDP and are available beginning with FY 1981. When any PB is published, the congressional actions are complete on the prior PB and the year prior data reflect the action of the Congress on that year. For example, the FY 1997 year of the FY 1998 PB reflects the congressional action on the first year of the FY 1997 PB.

Also in the current display, as in the historical display, expended data reflect data taken from the latest PB information of years before the year that represents appropriated data. Thus, for the FY 1998 PB, FY 1997 represents appropriated information, and all years from FY 1975 through FY 1996 reflect actual expenditures or obligations. The DoDSPEAR model uses the terms expended and obligated interchangeably. During data preprocessing, the expended data are updated, if necessary, back to FY 1975 with each successive PB. Expended data change up to 8 years after the enactment of the DoD Appropriation Bill due to reprogramming and normal procedures in obligating appropriated funds.
3.2 USING DODSPEAR

When you select the executable file DODSPEAR.EXE by double clicking the icon or through a program manager, the screen in Figure 3-3 appears.

![Figure 3-3. DoDSPEAR Opening Screen](image)

3.2.1 DoDSPEAR Menu Choices

Each item on the menu bar for DoDSPEAR, shown at left, is explained below.

3.2.2 Exiting DoDSPEAR

The only item under the “File” menu is “Exit,” which returns you to Windows.

3.2.3 Updating DoDSPEAR

Only the data developers use the “Update” menu item. It is included on the model menu for convenience and is not accessible to the normal user.

3.2.4 The “Help” Menu

The “Help” menu provides information on the database design as well as a way to view this user’s guide on-line.
3.2.5 The “Analyze” Menu

The primary menu item for the user is the “Analyze” menu. From this menu, you select the type of analysis to be performed. The menu choices are explained in turn in the following subsections. Each choice results in one of the two model output formats explained under Section 3.1, Data Display Overview.
3.3 SINGLE PE

Select "Single PE" from the "Analyze" menu of DoDSPEAR when the PE to be analyzed is known and the model's search capabilities are not required.

3.3.1 Entering the PE Number

The dialog box in Figure 3-4 is displayed.

![Figure 3-4. "Single PE" Dialog Box](image)

Enter a Program Element (PE) number to enable the selection buttons. The PE must be 8-10 characters long and include the service designator. If you enter an invalid PE, the message in Figure 3-5 is displayed. Click "OK" and reenter a valid number or click "Cancel" to close the dialog box.

![Figure 3-5. Invalid PE Entry Notice](image)

Once you have entered a correct PE, click either the "Plot Current" or the "Plot Historical" button to proceed. Each choice leads to the display of FYDP data over multiple positions for this single PE as outlined in Section 3.1, Data Display Overview.

The following subsections describe each of the two choices. After gaining some experience with DoDSPEAR, you will know which is best suited for your work.
3.3.2 Plotting a Current Display

![Current Plot Selection Dialog Box](image)

Figure 3-6. “Current Plot Selection” Dialog Box

After you click “Plot Current,” the dialog box in Figure 3-6 opens. The PE number and the title (space permitting) appear at the top in the title bar.

### 3.3.2.1 Selecting Years to be Plotted

The “Plot” area of the dialog box allows you to select the beginning and end year for the subsequent plot of the data. The range is normally 11 years, but can be changed as desired.

To change the default years, first select a new “Start year” from the drop-down list. The available choices range from 1975 to the end year of the current FYDP minus one. For the FY 1998 PB, this last year choice is 2002.

When a new “Start year” is chosen, the “End year” will automatically change to the start year plus ten. Select a different “End year” from the drop-down list, if desired. The “End year” must be at least one year higher than the “Start year.” If you enter a year that does not meet that criteria, the end year automatically changes so that it does.

### 3.3.2.2 Selecting Positions to be Plotted

Select the check box next to the position name on the “Current Plot Selection” dialog box to include that position in the
final plot. You may select one or all of the positions to be included in the plot.

3.3.2.3 Plotting a Trend Line

The final area of the dialog box is the “Plot trend” option. This check box includes a line for the calculated trend of the indicated data position. The TOA trend line is calculated in the data processing procedure for the most recently loaded FYDP position. Note: This trend line is in then-year dollars and includes the effects of inflation.

If “Plot trend” is checked, the “Trend” area is enabled and you may select the start and end year for the trend line. The default years are the FYDP years of the latest FYDP position (i.e., for the FY 1999 POM, the FYDP years are FY 1999–FY 2003). The notation “(POM)” following the words “Plot trend” indicates the position of the pre-computed data. You may select other start or end years within the current FYDP year range. If your selection is other than the pre-computed default years, the trend data will be recalculated using the years you selected. This feature is particularly useful if the data deviate significantly from the trend for a few years and you wish to see the trend over only a more consistent period.

Figure 3-7 shows an example of a trend line. The value of the slope of the trend line is shown on the plot as well. The trend line is a least-squares fit to the selected data.
3.3.2.4 Generating the Current Plot

After you select a FYDP position, the “Plot” button is enabled. When you are finished filling out the “Current Plot Selection” dialog box, click the “Plot” button to generate the plot.

3.3.2.5 Viewing the Current Plot

After you click the “Plot” button, the model queries the databases for data by the PE number, the highest aggregation of data available for a “Single PE” analysis. The model also queries the databases for the next lower level of data in case you later want to see that lower level data.

Figure 3-8 is an example of the resulting plot. The PE number and title are shown across the top of the plot along with the Defense Mission Category (DMC) name and three-digit number for that DMC. The slope of the trend line is shown. The tabular data are the values for the selected position for each year selected. The current computer date and classification information are shown along the bottom of the resulting plot.

Figure 3-8. Current Display for a Single PE
Unclassified Sample: For Training Purposes Only

3-12
As explained in Section 3.1, the line labeled “POM” represents the values in each year for this PE in the fiscal year for which the POM was prepared.

The grid shows the values from FYDP data in millions of then-year dollars for this PE. The chart plots these values. The FY 1994 value is from the FY 1994 POM, FY 1995 is from the FY 1995 POM, FY 1996 is from the FY 1996 POM, FY 1997 is from the FY 1997 POM, FY 1998 is from the FY 1998 POM, and FY 1999 through FY 2003 are from the FY 1999 POM. In this example, since FY 1992 was not included in the plot, there is no value for FY 1993. This then is the track of the values for this PE from POM to POM. All values are in then-year dollars, so different economic assumptions are implied by each year’s value.

The trend line and the trend slope (+$4.026 million) are taken from the FY 1999 POM data.

Figure 3-9 shows the addition of the line representing the PB. This is accomplished by closing the plot (see Section 3.3.2.6), returning to the “Current Selection Plot” dialog box, and clicking the “PB” check box.

![Trend Chart](image)

**Figure 3-9. Addition of PB Data to POM Data**

*Unclassified Sample: For Training Purposes Only*
With the addition of the PB data in Figure 3-8, some analysis can begin. The $116 million increase in funding in 1996 between the POM and PB is because each line represents FY 1996 in the respective FY 1996 FYDP position. Perhaps it is worth investigating the reason for the increase. Also note the increase in funding between the POM and PB positions for FY 1998 through FY 2003 and how the trend line is nearly a perfect fit to the data.

3.3.2.6 Minimizing, Expanding, and Closing the Plot

Notice the upper right corner of the plot. Using standard Windows features, you can minimize the plot, expand it to full screen, or close it. Expanding the plot to full screen allows you to see more of the details in the graph.

3.3.2.7 Changing the Display

After returning to the “Current Plot Selection” dialog box, if you make the choice of trend line from FY 2000 to FY 2003, and request the expended data back to FY 1988, as shown here, the chart changes as shown in Figure 3-10.
Trend (POM) is 5.8925 $M per year

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>POM</td>
<td>38,267</td>
<td>191,050</td>
<td>95,856</td>
<td>376,313</td>
<td>480,367</td>
<td>403,239</td>
<td>46,126</td>
<td>20,633</td>
<td>218,722</td>
<td>246,653</td>
<td>548,700</td>
<td>556,156</td>
<td>565,341</td>
<td>531,393</td>
<td>71,218</td>
<td></td>
</tr>
<tr>
<td>PB</td>
<td>67,151</td>
<td>182,480</td>
<td>407,463</td>
<td>691,332</td>
<td>691,332</td>
<td>691,332</td>
<td>691,332</td>
<td>691,332</td>
<td>691,332</td>
<td>691,332</td>
<td>691,332</td>
<td>691,332</td>
<td>691,332</td>
<td>691,332</td>
<td>691,332</td>
<td></td>
</tr>
<tr>
<td>Expended</td>
<td>467,731</td>
<td>475,325</td>
<td>475,721</td>
<td>496,547</td>
<td>668,589</td>
<td>566,800</td>
<td>493,608</td>
<td>389,563</td>
<td>393,230</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 3-10. Addition of Expended Data
*Unclassified Sample: For Training Purposes Only*

There are several things to note. The trend has been recalculated and plotted for just FY 2000 through FY 2003. The new value is $5.8925 million per year. The x-axis has been extended backward to FY 1988 and the “expended” data added. Simultaneously, the POM and PB data from FY 1988 to FY 1993 have been added. Note that there was no POM or PB in FY 1989, and the model simply connects the FY 1988 and FY 1990 values. Also, the data are not displayed fully in the grid. If you maximize the display, the numbers in the grid will become more readable. You can also resize individual columns in the data grid.

Figure 3-11 depicts the same data but only for the PB and the Appropriated values.
Appropriated values represent the work of the Congress during its review of the PB. These values are taken from each PB FYDP as the year before the start of the FYDP years. For example, the FY 1994 appropriated value is taken from the FY 1994 column of the FY 1995 PB, the FY 1995 value is taken from the FY 1995 column of the FY 1996 PB, and so on. From these data, it is obvious that the Congress has reduced this program each year. Why? Was this a result of general cuts to all programs or is there something in this program that the Congress does not agree with?

3.3.2.8 Changing the Plot Characteristics ("Gallery," "Style," "Features," and "Annotate" Menus)

The menu bar on the chart display allows you to analyze the makeup of the PE and change the style and form of the chart. These style and form menu items are applicable to all displayed charts, whether current or historical.

Figure 3-12 shows the menu choices when a chart is displayed.
The “Gallery,” “Style,” “Features,” and “Annotate” menus deal with the appearance of the chart.

The “Gallery” menu allows you to select the type of chart you want. The default value is line graph. The other choices are self-explanatory. To change the type of chart, select the desired type from the list.

The “Style” menu at right applies to a line-type chart. If you select a different format under the “Gallery” menu, the “Style” menu will change to fit that style. For example, the “Style” menu below is appropriate for the “2D Bar” choice on the “Gallery” menu.

Each submenu of the “Features” menu is shown below.
The “Annotate” menu shown here allows you to add text, lines, or arrows to the display as desired. These features are convenient for highlighting certain areas of the chart before printing.

3.3.2.9 Copying, Saving, Printing, and Exiting the Plot

The “File” menu allows you to copy the active chart to the clipboard with the first menu item. This picture can then be pasted into documents as necessary. The “Print” menu item sends the chart with grid to the default printer. The “Printer Setup…” menu calls the standard Windows printer setup dialog box. To close the graph, select “Close.”

The “Save” menu gives you the choice to save either the chart or the data sheet (grid). Selecting “Graph” brings up the dialog box in Figure 3-13.

![Figure 3-13. “Save As” Dialog Box](image)

From here you can save the chart as a Windows MetaFile or a BitMap file in any directory on any drive on your computer.
Selecting “Save” and “Data Sheet” from the “File” menu displays the “Save Data Sheet” dialog box, at right. With these choices you can save to a text file the data associated with this chart or all the data associated with the PE or PEs selected. Multiple PEs are discussed in a later section.

The text file is saved as a tab-delimited file and can readily be opened in Microsoft Excel and parsed to become a spreadsheet. Then you can create your own graphs using Excel or another graphical package. In the example, you would select “All RICs for ALL RAGs for current PE.” How to see the RIC detail is discussed in a later section.

Selecting “Print All” and “Program Elements” from the “File” menu displays the “Printer Setup” dialog box below right.

This dialog box is designed for choices other than the “Single PE” choice. When multiple PEs are picked for charting, you may want to print all the charts at once. Or maybe you want to print
a chart with data only in the relevant period of interest. Here you can select the years and, if the PE has no data for those years, the chart will not be printed. You can also set a common set of axis values for all charts using the optional boxes shown. This will put all printed charts on the same scale so you can visually scan the printouts to find those that are anomalous.

Selecting “Print All” and “RAGs” from the “File” menu produces the same dialog box shown above. Now, however, the charts at the RAG level will be printed for all RAGs associated with the PE or PEs selected.

will be printed for all RICs associated with the PE or PEs selected. This could be a considerable number of charts to be printed. Use this menu feature only if you are confident that you want that many charts and that your printer can be tied up for a reasonably long period of time.

3.3.2.10 Changing the View (“Percent of TOA” and “Redefine TOA”)

The “View” menu allows you to change the chart in several ways. If you want to know the percent of TOA represented by this particular PE, select the first menu item. The left axis of the plot and the grid will change to percentages rather than dollars. The default value of TOA is total DoD TOA. Selecting the second menu item displays the “Redefine TOA” dialog.
Use the check boxes to change the TOA to be included in the percentage of TOA calculation. Using this feature, you can determine the percentage of any service TOA or combination of services TOA represented by the PE or PEs selected. Changing a check box enables the “OK” button.

The “Year vs. Amount” menu item is the default. A previous version of the model allowed other choices, but those have been deleted from the current version.

The “Hide Data Sheet” choice removes the data grid from the display and enlarges the chart. This enlargement is often useful to see additional detail in the chart. The “View” menu item then changes to “Show Data Sheet.” You can toggle between the two settings.

The “Set Max Range” menu item allows you to set the scale of the y-axis rather than accepting the default value driven by the data. This is helpful when you want to see all charts on the same scale regardless of the actual values of the data.

After “Set Max Range” is selected, the left dialog box in Figure 3-14 is displayed if you are viewing dollars. If the data being plotted are personnel or forces, the dialog box on the right in Figure 3-14 appears.

![Set Max Range Dialog Boxes](image)

**Figure 3-14. “Set Max Range” Dialog Boxes**

### 3.3.2.11 Displaying Data to the RIC and RAG Levels

We have mentioned RAGs and RICs several times. These sub-PE-level data are accessed using the “RAGs” menu. When you select a PE for charting, the RAG menu shown here is displayed.

The discussion so far has concerned only the PE level of TOA data. DoDSPEAR can display the data below the PE level. The next lower level is RAG
(Resource Aggregation Group). For TOA data, a RAG is equivalent to a budget title such as RDT&E, Procurement, O&M, and so on. For personnel, a RAG indicates active, National Guard or reserve officers or enlisted personnel, or civilians. For forces, a RAG indicates a collection of similar force elements such as bombers, carriers, or maneuver battalions. RAGs are groups of similar RICs (Resource Identification Code). RICs equate to congressional appropriations in dollar terms, types of equipment or units for forces, and personnel categories such as active, reserve, National Guard, officer, enlisted, and civilian.

Figure 3-15 shows the menu appropriate to the PE being used in the example. This menu is populated only with those RAGs that have non-zero values in one or more years for the PE(s) and year range selected. The two-character RAG is shown with its title. Selecting any single item causes the chart to display that data and changes the y-axis label and value accordingly. There are standard subsets of RAGs as shown for major groupings of TOA only. Selecting one of these, such as O&S, causes the model to display aggregated data on the chart. To make your own combination of RAGs for charting, select “User-defined Subset.”

<table>
<thead>
<tr>
<th>Standard Subsets</th>
<th>Investment</th>
</tr>
</thead>
<tbody>
<tr>
<td>User-defined Subset ...</td>
<td>MilCon</td>
</tr>
<tr>
<td>00 RDT+E</td>
<td>MilPay</td>
</tr>
<tr>
<td>20 Military Construction</td>
<td>O&amp;M</td>
</tr>
<tr>
<td>40 Military Pay</td>
<td>O&amp;S</td>
</tr>
<tr>
<td>a0 Active Military Officers</td>
<td>Procurement</td>
</tr>
<tr>
<td>a1 Active Military Officer Students</td>
<td>R&amp;D</td>
</tr>
<tr>
<td>a2 Active Military Enlisted</td>
<td></td>
</tr>
<tr>
<td>c0 Civilian Direct Hire</td>
<td></td>
</tr>
<tr>
<td>i0 Bombers</td>
<td></td>
</tr>
<tr>
<td>i1 Tankers</td>
<td></td>
</tr>
<tr>
<td>i2 Fighter/Attack</td>
<td></td>
</tr>
<tr>
<td>13 Reconnaissance</td>
<td></td>
</tr>
<tr>
<td>14 Tactical Airlift</td>
<td></td>
</tr>
<tr>
<td>15 Strategic Airlift</td>
<td></td>
</tr>
<tr>
<td>16 Other Transport</td>
<td></td>
</tr>
<tr>
<td>17 AEW, Command + Control</td>
<td></td>
</tr>
<tr>
<td>b0 Utility</td>
<td></td>
</tr>
<tr>
<td>ic Training</td>
<td></td>
</tr>
<tr>
<td>More...</td>
<td></td>
</tr>
</tbody>
</table>

Figure 3-15. “RAGs” Submenus
Note that in this example there are more items than can be listed on the standard-size drop-down menu. Clicking on “More…” opens the dialog box in Figure 3-16. Using standard Windows functions with the Control or Shift key allows you to select one or all of the choices to group together. Of course it does not make sense to try and group unlike items.

The same dialog box opens when “User-defined Subset” is selected.

In the example in Figure 3-16, three types of people have been selected for plotting. Note that the list box is scrollable. All the types of equipment in this PE could have been selected to see the total number of aircraft and helicopters assigned to this PE.

![Select Plot Dialog Box](image)

Figure 3-16. “Select Plot” Dialog Box

Selecting data by RAG is particularly useful when PEs from more than one service are selected for analysis. RAGs are not service-specific, while RICs generally are.

Selecting the RAG of “i0” changes the chart data to display the number of bombers in this PE over the years selected. The model then queries the database for the next lower level of detail, the RIC. At the same time the “RICs” menu item is enabled. Selecting “RICs” presents the choices shown here.
Now you can plot just the data for a single RIC or, using the same dialog box shown in Figure 3-15, select a group of available RIC data.

If you select a RAG for dollars (such as “00 RDT&E”), the one or more RICs of that type would be displayed. In this example on a single PE, there is only one RIC for each dollar RAG. In this case the chart for the RAG and the RIC would be identical except for the chart titles. In a multiple service selection of PEs for display, or a DMC or IC display, multiple RICs would be on the drop-down list. Then you could use the “User-defined Subset” dialog box to pick your own set of RICs to be charted or select a single RIC.

3.3.2.12 Changing PEs Plotted

The “Program Elements” menu item lists the PEs you selected for charting. In this example of analyzing a single PE, there is only one listed, as shown.

When multiple PEs are selected, the list indicates which one is currently plotted by the check mark as shown. Notice that in addition to charting the single PE that is checked, you can select another PE by clicking on it, create a sum of PEs of your choosing, or chart the sum of all the PEs.

3.3.3 Plotting a Historical Display

The previous section concerned the menu options available when “Plot Current” was selected on the “Single PE” dialog box shown here. In this section, we discuss the differences when “Plot Historical” is selected. The “Single PE” method is again used for this example, but the instructions apply no matter which method of analysis you choose.
3.3.3.1 Selecting Position-Year Combinations

Click the “Plot Historical” button, and the “Historical Plot Selection” dialog box opens. See Figure 3-17 for an example.

<table>
<thead>
<tr>
<th>Position</th>
<th>Year</th>
<th>President</th>
</tr>
</thead>
<tbody>
<tr>
<td>POM</td>
<td></td>
<td>Reagan</td>
</tr>
<tr>
<td>BES</td>
<td></td>
<td>Bush</td>
</tr>
<tr>
<td>PB</td>
<td></td>
<td>Clinton</td>
</tr>
<tr>
<td></td>
<td>1988</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1989</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1990</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1991</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1992</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1993</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1994</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1995</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1996</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1997</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1998</td>
<td></td>
</tr>
</tbody>
</table>

Figure 3-17. “Historical Plot Selection” Dialog Box

To plot a historical chart, select the FYDP position(s) you want to compare. The PE selected is shown at the top of the dialog box. As the instructions indicate, click on the position of choice, then drag the mouse pointer to the year. Figure 3-18 shows two examples of the position-year combination. In the first, the mouse was clicked on the POM position and dragged to the year 1996. In the second, the PB position was dragged to the year 1994. Since there were two PB positions in 1994, you must also continue to drag the pointer to the particular presidential submittal you want to view. To delete a selection, click on the line joining the position and the year and press the Backspace key.
Position data are available back to the 1982 PB and include all FYDP positions since that time.

3.3.3.2 Selecting Appropriated or Expended Data

As seen at the lower left in Figure 3-18, in addition to the FYDP positions, you can select the “Other Positions” to see and “Expended” (or obligated) and “Appropriated” data. “Exercise” data are not included in this version of DoDSPEAR. Select either the “Expended” or “Appropriated” check box. The drop-down list of start years is then available. Data from 1975 forward are available.

3.3.3.3 Viewing the Historical Plot

When allowable choices are made, the “Plot” button is activated. Using the above example, if President Bush had been selected, the chart in Figure 3-19 would result.
Figure 3-19. Historical Display for a Single PE  
Unclassified Sample: For Training Purposes Only

It immediately becomes obvious that this program was reduced between the Bush 1994 PB and the 1996 POM. The reasons for the reduction may not be so obvious. Recall that each new PB introduces new inflation assumptions and these charts are in then-year dollars.

Each line in Figure 3-19 represents the 6 years of data in its respective position. Additional positions can be selected for comparisons.

All of the menu choices associated with this chart are the same as those discussed previously with "Plot Current". You can work your way down to the RIC level of data for dollars, personnel, or equipment assigned to this PE at each position.

3.3.3.4 Minimizing, Expanding, and Closing the Plot

Notice the upper right corner of the plot. Using standard Windows features, you can minimize the plot, expand it to full screen, or close it. Expanding the plot to full screen allows you to see more of the details in the graph.
3.3.3.5 Changing the Plot Characteristics ("Gallery," "Style," "Features," and "Annotate" Menus)

The menu bar on the chart display allows you to analyze the makeup of the PE and change the style and form of the chart. These style and form menu items are applicable to all displayed charts, whether current or historical.

Figure 3-20 shows the menu choices when a chart is displayed.

![Chart Menu Bar](image)

The "Gallery," "Style," "Features," and "Annotate" menus deal with the appearance of the chart.

The "Gallery" menu allows you to select the type of chart you want. The default value is line graph. The other choices are self-explanatory. To change the type of chart, select the desired type from the list.

The "Style" menu at right applies to a line-type chart. If you select a different format under the "Gallery" menu, the "Style" menu will change to fit that style. For example, the "Style" menu below is appropriate for the "2D Bar" choice on the "Gallery" menu.

![Style Menu](image)
Each submenu of the “Features” menu is shown below.

The “Annotate” menu shown here allows you to add text, lines, or arrows to the display as desired. These features are convenient for highlighting certain areas of the chart before printing.

3.3.3.6 Copying, Saving, Printing, and Exiting the Plot

The “File” menu allows you to copy the active chart to the clipboard with the first menu item. This picture can then be pasted into documents as necessary. The “Print” menu item sends the chart with grid to the default printer. The “Printer Setup…” menu calls the standard Windows printer setup dialog box. To close the graph, select “Close.”

The “Save” menu gives you the choice to save either the chart or the data sheet (grid). Selecting “Graph” brings up the dialog box in Figure 3-21.
From here you can save the chart as a Windows MetaFile or a BitMap file in any directory on any drive on your computer.

Selecting “Save” and “Data Sheet” from the “File” menu displays the “Save Data Sheet” dialog box, at right. With these choices you can save to a text file the data associated with this chart or all the data associated with the PE or PEs selected. Multiple PEs are discussed in a later section.

The text file is saved as a tab-delimited file and can readily be opened in Microsoft Excel and parsed to become a spreadsheet. Then you can create your own graphs using Excel or another graphical package. In the example, you would select “All RICs for ALL RAGs for current PE.” How to see the RIC detail is discussed in a later section.
Selecting “Print All” and “Program Elements” from the “File” menu displays the “Printer Setup” dialog box below right.

This dialog box is designed for choices other than the “Single PE” choice. When multiple PEs are picked for charting, you may want to print all the charts at once. Or maybe you want to print a chart with data only in the relevant period of interest. Here you can select the years and, if the PE has no data for those years, the chart will not be printed. You can also set a common set of axis values for all charts using the optional boxes shown. This will put all printed charts on the same scale so you can visually scan the printouts to find those that are anomalous.

Selecting “Print All” and “RAGs” from the “File” menu produces the same dialog box shown above. Now, however, the charts at the RAG level will be printed for all RAGs associated with the PE or PEs selected.

Selecting “File,” “Print All,” “RICs,” and “For All RAGs” results in the same dialog as above. Now,
however, the charts at the RIC level will be printed for all RICs associated with the PE or PEs selected. This could be a considerable number of charts to be printed. Use this menu feature only if you are confident that you want that many charts and that your printer can be tied up for a reasonably long period of time.

3.3.3.7 Changing the View ("Percent of TOA" and "Redefine TOA")

The "View" menu allows you to change the chart in several ways. If you want to know the percent of TOA represented by this particular PE, select the first menu item. The left axis of the plot and the grid will change to percentages rather than dollars. The default value of TOA is total DoD TOA. Selecting the second menu item displays the "Redefine TOA" dialog.

Use the check boxes to change the TOA to be included in the percentage of TOA calculation. Using this feature, you can determine the percentage of any service TOA or combination of services TOA represented by the PE or PEs selected. Changing a check box enables the "OK" button.

The "Year vs. Amount" menu item is the default. A previous version of the model allowed other choices, but those have been deleted from the current version.

The "Hide Data Sheet" choice removes the data grid from the display and enlarges the chart. This enlargement is often useful to see additional detail in the chart. The "View" menu item then changes to "Show Data Sheet." You can toggle between the two settings.

The "Set Max Range" menu item allows you to set the scale of the y-axis rather than accepting the default value driven by the data. This is helpful when you want to see all charts on the same scale regardless of the actual values of the data.

After "Set Max Range" is selected, the left dialog box in Figure 3-22 is displayed if you are viewing dollars. If the data being plotted are personnel or forces, the dialog box on the right in Figure 3-22 appears.
3.3.3.8 Displaying Data to the RIC and RAG Levels

We have mentioned RAGs and RICs several times. These sub-PE-level data are accessed using the “RAGs” menu. When you select a PE for charting, the RAG menu shown here is displayed.

The discussion so far has concerned only the PE level of TOA data. DoDSPEAR can display the data below the PE level. The next lower level is RAG (Resource Aggregation Group). For TOA data, a RAG is equivalent to a budget title such as RDT&E, Procurement, O&M, and so on. For personnel, a RAG indicates active, National Guard or reserve officers or enlisted personnel, or civilians. For forces, a RAG indicates a collection of similar force elements such as bombers, carriers, or maneuver batallions. RAGs are group of similar RICs (Resource Identification Code). RICs equate to congressional appropriations in dollar terms, types of equipment or units for forces, and personnel categories such as active, reserve, National Guard, officer, enlisted, and civilian.

Figure 3-23 shows the menu appropriate to the PE being used in the example. This menu is populated only with those RAGs that have non-zero values in one or more years for the PE(s) and year range selected. The two-character RAG is shown with its title. Selecting any single item causes the chart to display that data and changes the y-axis label and value accordingly. There are standard subsets of RAGs as shown for major groupings of TOA only. Selecting one of these, such as O&S, causes the model to display aggregated data on the chart. To make your own combination of RAGs for charting, select “User-defined Subset.”
Note that in this example there are more items than can be listed on the standard-size drop-down menu. Clicking on “More…” opens the “Select Plot” dialog box in Figure 3-24. Using standard Windows functions with the Control or Shift key allows you to select one or all of the choices to group together. Of course it does not make sense to try and group unlike items.
The same dialog box opens when “User-defined Subset” is selected.

In the example in Figure 3-24, three types of people have been selected for plotting. Note that the list box is scrollable. All the types of equipment in this PE could have been selected to see the total number of aircraft and helicopters assigned to this PE.

Selecting data by RAG is particularly useful when PEs from more than one service are selected for analysis. RAGs are not service-specific, while RICs generally are.

Selecting the RAG of “i0” changes the chart data to display the number of bombers in this PE over the years selected. The model then queries the database for the next lower level of detail, the RIC. At the same time the “RICs” menu item is enabled. Selecting “RICs” presents the choices shown here. Now you can plot just the data for a single RIC or, using the same dialog box shown in Figure 3-23, select a group of available RIC data.

If you select a RAG for dollars (such as “00 RDT&E”), the one or more RICs of that type would be displayed. In this example on a single PE, there is only one RIC for each
dollar RAG. In this case the chart for the RAG and the RIC would be identical except for the chart titles. In a multiple service selection of PEs for display, or a DMC or IC display, multiple RICs would be on the drop-down list. Then you could use the “User-defined Subset” dialog box to pick your own set of RICs to be charted or select a single RIC.

3.3.3.9 Changing PEs Plotted

The “Program Elements” menu item lists the PEs you selected for charting. In this example of analyzing a single PE, there is only one listed, as shown.

When multiple PEs are selected, the list indicates which one is currently plotted by the check mark as shown. Notice that in addition to charting the single PE that is checked, you can select another PE by clicking on it, create a sum of PEs of your choosing, or chart the sum of all the PEs.
3.4 CROSS-CUT PEs

Cross-cut PEs are those elements assigned the same last two numbers in the PE numbering system so that special analyses can be accomplished more easily. Cross-cut PEs are used to identify special-interest activities that cut across major force programs and services. Figure 3-25 shows the list of cross-cut PE categories. The programs that share the common PE ending also share the same attributes, meaning their resources are for the common purpose indicated. There are over 500 program elements with the common ending that are not cross-cut PEs. Those elements are annotated in the database to exclude them from the cross-cut analyses.

![Figure 3-25. “Cross-Cut PEs” Submenu](image)

3.4.1 Selecting the Cross-Cut Category

Select the cross-cut category for which you want to see PEs. The list for Child Development is shown in Figure 3-26. These are all the PEs that end in the number “19” and are titled “Child Development.” Other PEs that end in “19” and are not related to “Child Development” have been coded as non-cross-cut in the model software.
There are 15 PEs in the list. Select one or more PEs to analyze (Hold the CTRL key to select more than one, the SHIFT key to select a range).

<table>
<thead>
<tr>
<th>Code</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>0208719F</td>
<td>Child Development</td>
</tr>
<tr>
<td>0305919F</td>
<td>Child Development</td>
</tr>
<tr>
<td>0408719F</td>
<td>Child Development</td>
</tr>
<tr>
<td>0708719F</td>
<td>Child Development</td>
</tr>
<tr>
<td>0805719F</td>
<td>Child Development - Service Academies</td>
</tr>
<tr>
<td>0808719F</td>
<td>Child Development</td>
</tr>
<tr>
<td>0908719F</td>
<td>Child Development</td>
</tr>
<tr>
<td>0208719A</td>
<td>Child Development</td>
</tr>
<tr>
<td>0708719A</td>
<td>Child Development</td>
</tr>
<tr>
<td>0805719A</td>
<td>Child Development - Service Academies</td>
</tr>
<tr>
<td>0808719A</td>
<td>Child Development</td>
</tr>
<tr>
<td>0208719N</td>
<td>Child Development</td>
</tr>
<tr>
<td>0508719N</td>
<td>Child Development</td>
</tr>
<tr>
<td>0808719N</td>
<td>Child Development</td>
</tr>
<tr>
<td>0808719M</td>
<td>Child Development</td>
</tr>
</tbody>
</table>

Figure 3-26. “Child Development” PE List

Notice that PEs from more than one service are shown.

3.4.2 Sorting, Printing, and Saving the PE List

Use the buttons at the bottom of the screen shown in Figure 3-26 to sort the list of PEs by service, code (PE number), or title. To print the list of PEs, click the “Print List” button. To save the list of PEs, click the “Save List” button. These functions are common to all lists of PEs.

3.4.3 Selecting PEs to Analyze

Select one or more of the PEs from the list for plotting, and use the “Plot Current” or the “Plot Historical” button. Refer to sections 3.3.2 and 3.3.3 for descriptions of the current and historical displays.
3.4.4 Cross-Cut PE Plot Display

If you select more than one PE on the list, the chart that is displayed initially is for the first PE you selected. You can select another PE to be plotted from the “Program Elements” menu shown in Figure 3-27. Notice that you can select a single PE, the sum of all the PEs, or make up your own combination of PEs to be plotted.

![DoD SPEAR Table]

Figure 3-27. “Program Elements” Menu

Figure 3-28 shows the result of selecting the sum of the PEs. Note that the title of the chart includes the PE numbers selected.
Figure 3-28. Historical Display for Cross-Cut PEs

Unclassified Sample: For Training Purposes Only

All the menu items discussed in subsections 3.3.2.8 through 3.3.2.11 are also available here.
3.5 ANALYZE PEs IN A DMC

The next possible method of analysis is to look at PEs assigned to a Defense Mission Category (DMC).

3.5.1 Selecting a DMC

To find the programs in a particular DMC, first select the one-digit DMC (Major Force Missions, Defense-Wide Missions, or Defense-Wide Support Missions) then the three-digit DMC from the resulting submenus.

The menu in Figure 3-29 represents one possible selection. In this example, the analyst wants to see the data for the PEs in the Tactical Air Forces DMC. Included on the right-most submenu are the other three-digit DMCs in the “Major Force Mission” DMC.

![Figure 3-29. “PEs in a DMC” Submenus](image)

Selecting “Defense-Wide Missions” or “Defense-Wide Support Missions” results in a different submenu of three-digit DMCs. These are shown in Figure 3-30.
3.5.2 Showing All PEs Within the DMC

When the example choice of DMC 122 is selected, the menu shown here is activated. If “Show All” is selected, the list box shown in Figure 3-31 on the next page is activated. The list contains over 500 entries.

3.5.3 Sorting, Printing, and Saving the PE List

Use the buttons at the bottom of the screen shown in Figure 3-31 to sort the list of PEs by service, code (PE number), or title. To print the list of PEs, click the “Print List” button. To save the list of PEs, click the “Save List” button. These functions are common to all lists of PEs.

3.5.4 Selecting PEs to Analyze After “Show All”

Select one or more of the PEs from the list for plotting, and use the “Plot Current” or the “Plot Historical” button. Refer to sections 3.3.2 and 3.3.3 for descriptions of the current and historical displays.
3.5.5 Searching the DMC by Trend

Instead of showing all PEs, you can search the DMC by various comparisons to narrow the list of PEs in this DMC. As shown in Figure 3-32, select “Search By.”

After you select “Trend” from the resulting submenu, the dialog box in Figure 3-33 opens. You can look for PEs where the slope of the trend line is increasing or
decreasing, or you can select both to find possible pairs of PEs that have mirror images of funding. Select the degree of increase or decrease by entering a value in the box labeled “$ Millions per year.” Selecting the “R squared” radio button activates the bottom half of the dialog box. This is used to look for programs that do not have a smooth increase or decrease in funding. The trend line is a common least-squares fit to the data. By looking for those PEs with poor $R^2$ values, you will find those PEs that have sudden changes. Values of $R^2$ are between zero and one.

![Figure 3-33. “Trend” Dialog Box](image)

For example, if you select “Slope,” then both “increasing” and “decreasing” (a logical OR), and enter “50” for the millions of dollars, the result would be a list of 13 PEs in the FY 1999 POM after you click “Search.” For a second example, select “R squared” and “less” than a value of “.5” to see a list of 57 PEs. These may be the first programs to analyze.

3.5.6 Searching the DMC by Expended versus Appropriated

To search the selected DMC by “Expended vs. Appropriated,” select that entry on the menu shown in Figure 3-32. The dialog box in Figure 3-34 opens. This analysis may highlight those programs that are not spending their funds in compliance with congressional direction and makes them targets for congressional reductions in future years.
You can search the DMC for those PEs where expended differs from appropriated by either a percentage or a dollar value you specify, as shown by the dialog boxes in Figures 3-34 and 3-35, respectively.

![Figure 3-34. “Expended vs. Appropriated” Percentage Difference Dialog Box](image)

![Figure 3-35. “Expended vs. Appropriated” Dollar Difference Dialog Box](image)

Enter the percentage value (0-100%) or the dollar amount in millions as appropriate.

### 3.5.7 Searching the DMC by Appropriated Versus Budgeted

The remaining choice for a search of the DMC, as shown in Figure 3-32, for PEs is to compare “Appropriated vs. Budgeted.” As in the previous search, this can be by percentages or dollars, as shown in Figures 3-36 and 3-37. This search will find those programs that were changed by Congress. This is computed as the difference between the first year of the FYDP for a President’s Budget and the first year before the FYDP in the
subsequent PB. For example, the data for FY 1997 in the FY 1997 PB are compared to FY 1997 values in the FY 1998 PB. These data are pre-calculated for a 5-year average.

Figure 3-36. “Appropriated vs. Budgeted” Percentage Difference Dialog Box

Figure 3-37. “Appropriated vs. Budgeted” Dollar Difference Dialog Box

Enter the percentage value (0-100%) or the dollar amount in millions as appropriate.

3.5.8 Selecting PEs to Analyze After a Search

At the completion of any of these search methods, the list box with the resulting PEs listed is displayed. This is similar to the list box in Figure 3-31. Select one or more of the PEs for plotting, and click the “Plot Current” or the “Plot Historical” button. Refer to sections 3.3.2 and 3.3.3 for descriptions of the current and historical displays.
3.6 ANALYZE DMC DATA

The next choice under the “Analyze” menu is “DMC Data.” For these data, all the values have been aggregated by DMC from the data for each appropriate PE. As can be seen in Figure 3-38, the data may be viewed at the one-digit, three-digit, or five-digit DMC level.

![Figure 3-38. “DMC Data” Submenu](image)

If you select the “5-digit DMC” menu item, the dialog box in Figure 3-39 opens.

3.6.1 Sorting, Printing, and Saving the DMC List

Use the buttons at the bottom of the screen shown in Figure 3-39 to sort the list of DMCs by code (DMC number) or title. To print the list of DMCs, click the “Print List” button. To save the list of DMCs, click the “Save List” button. These functions are common to all lists of DMC data, whether for one-digit, three-digit, or five-digit DMCs.

3.6.2 Selecting DMCs to Analyze

Select one or more of the DMCs from the list for plotting, and use the “Plot Current” or the “Plot Historical” button. Refer to sections 3.3.2 and 3.3.3 for descriptions of the current and historical displays.
3.6.3 Finding the DoD Total Funding

Selecting “DMC Data” from the “Analyze” menu is the easiest way to see the entire DoD funding at any position. Select “1-digit DMC” (Figure 3-38), then select all three one-digit DMCs from the resulting dialog box (similar to Figure 3-39). Select either “Plot Current” or “Plot Historical” to generate the plot. Then select “Sum of 1-digit DMCs” when the plot is displayed. See the revised chart menu in Figure 3-40. The menu item that was marked “Program Elements” under the previously discussed methods of analysis has changed to read “1-digit DMC.” This menu item is context-sensitive and will change depending on the previous menu choices made.

From this point you can find the DoD total for any single RAG or RIC, or any combination desired. Refer to sections 3.3.2 or 3.3.3 for the discussion of “Plot Current” or “Plot Historical,” respectively.
<table>
<thead>
<tr>
<th></th>
<th>1-digit DMCs</th>
<th>RAGs</th>
<th>Gallery</th>
<th>Style</th>
<th>Features</th>
<th>View</th>
<th>Annotate</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Sum of 1-digit DMCs</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>User-defined Subset</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>1</strong></td>
<td>Major Force Missions</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>2</strong></td>
<td>Defense-Wide Missions</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>3</strong></td>
<td>Defense-Wide Support Missions</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 3-40. Revised “1-digit DMCs” Menu
3.7 ANALYZE PEs IN AN INFRASTRUCTURE CATEGORY

In addition to finding PEs within Defense Mission Categories, you can also find PEs by searching Infrastructure Categories (ICs). By using the menu choice shown in Figure 3-41, you can analyze PEs by the eight major ICs.

![Figure 3-41. "PEs in an Infrastructure" Submenu]

3.7.1 Selecting an IC

To find the programs in a particular IC, select the IC by name from the list in Figure 3-41.

For this example, suppose you want to see the data for the PEs in the Force Management IC.

3.7.2 Showing All PEs Within the DMC

When you select the example choice of Force Management IC, the menu shown here opens. If you select “Show All,” the dialog box in Figure 3-42 opens. Notice that there are over 550 entries.

3.7.3 Sorting, Printing, and Saving the PE List

Use the buttons at the bottom of the screen shown in Figure 3-42 to sort the list of PEs by service, code (PE number), or title. To print the list of PEs, click the “Print List”
button. To save the list of PEs, click the “Save List” button. These functions are common to all lists of PEs.

![Force Management](image)

Figure 3-42. “Force Management” PE List

3.7.4 Selecting PEs to Analyze After “Show All”

Select one or more of the PEs from the list for plotting, and use the “Plot Current” or the “Plot Historical” button. Refer to sections 3.3.2 and 3.3.3 for descriptions of the current and historical displays.

3.7.5 Searching the IC by Trend

As shown in Figure 3-43, you can also do a search of the IC by various comparisons to narrow the list of PEs in this IC.
If you select “Trend,” the dialog box in Figure 3-44 opens. You can select to look for PEs where the slope of the trend line is increasing or decreasing, or you can select both to find possible pairs of PEs that have mirror images of funding. The degree of increase or decrease is selected by entering a value in the box labeled “$ Millions per year.” Selecting the “R squared” radio button activates the bottom half of the dialog. This is used to look for programs that do not have a smooth increase or decrease in funding. The trend line is a common least-squares fit to the data. By looking for those PEs with poor R^2 values, you will find those PEs that have sudden changes. Values of R^2 are between zero and one.

For example, if you select “Slope,” then “increasing” and “decreasing” (a logical OR), and insert “50” for the millions of dollars, the result would be a list of 3 PEs in the FY 1999 POM after you click “Search.” For a second example, select “R squared” and
“less” than a value of “.5” to see a list of 52 PEs. These may be the first programs to analyze.

3.7.6 Searching the IC by Expended versus Appropriated

To search the selected IC by “Expended vs. Appropriated,” select that entry on the menu in Figure 3-43. The dialog box in Figure 3-45 opens. This analysis may highlight those programs that are not spending their funds in compliance with congressional direction and makes them targets for congressional reductions in future years.

You can select to search the IC for those PEs where expended differs from appropriated by either a percentage or by a dollar difference you specify, as shown by the dialog boxes in Figures 3-45 and 3-46, respectively.

![Figure 3-45. “Expended vs. Appropriated” Percentage Difference Dialog Box](image)

![Figure 3-46. “Expended vs. Appropriated” Dollar Difference Dialog Box](image)
Enter the percentage value (0-100%) or the dollar amount in millions, as appropriate.

3.7.7 Searching the IC by Appropriated versus Budgeted

The remaining choice for a search of the IC for PEs is to compare “ Appropriated vs. Budgeted.” As in the previous search, this can be by percentages or dollars. This search will find the programs that were changed by Congress. This is computed as the difference between the first year of the FYDP for a President’s Budget and the first year before the FYDP in the subsequent PB. For example, the data for FY 1997 in the FY 1997 PB are compared to FY 1997 values in the FY 1998 PB. These data are pre-calculated for a 5-year average.

![Figure 3-47. “Appropriated vs. Budgeted” Percentage Difference Dialog Box](image)

![Figure 3-48. “Appropriated vs. Budgeted” Dollar Difference Dialog Box](image)
Enter the percentage value (0-100%) or the dollar amount in millions, as appropriate.

3.7.8 Selecting PEs to Analyze After a Search

At the completion of any of these search methods, the list box with the resulting PEs is displayed. This is similar to the list box in Figure 3-42. Select one or more of the PEs for plotting, and click the “Plot Current” or the “Plot Historical” button. Refer to sections 3.3.2 and 3.3.3 for descriptions of the current and historical displays.
3.8 ANALYZE INFRASTRUCTURE DATA

The “Infrastructure Data” selection is similar to analyzing DMC Data discussed in section 3.6. For these data, all the values have been aggregated by IC from the data for each appropriate PE. As can be seen in Figure 3-49, the data may be viewed at the “Mission/IC” (one-digit), “Infrastructure Category” (4-digit), or “Infrastructure Subcategory” (five-digit) IC level.

![DoD SPEAR Submenu](image)

*Figure 3-49. “Infrastructure Data” Submenu*

If you select “Infrastructure Subcategory” the dialog box in Figure 3-50 opens.

3.8.1 Sorting, Printing, and Saving the IC List

Use the buttons at the bottom of the screen shown in Figure 3-50 to sort the list of ICs by code (IC) or title. To print the list of ICs, click the “Print List” button. To save the list of ICs, click the “Save List” button. These functions are common to all lists of ICs.

3.8.2 Selecting ICs to Analyze

Select one or more of the ICs from the list for plotting, and use the “Plot Current” or the “Plot Historical” button. Refer to sections 3.3.2 and 3.3.3 for descriptions of the current and historical displays.
3.8.3 Finding the DoD Total Funding

Selecting “IC Data” from the “Analyze” menu is an easy way to see the entire DoD funding at any position. Use the “Mission/IC” menu (Figure 3-49), then select both “Mission Forces” and “Infrastructure” from the resulting dialog box (similar to Figure 3-50). Select either “Plot Current” or “Plot Historical” to generate the plot. Then select “Sum of Mission/ICs” when the plot is displayed. See the revised chart menu in Figure 3-51. The menu item that was marked “Program Elements” under the previously discussed methods of analysis has been changed to read “Mission/ICs.” This menu item is context-sensitive and will change depending on the previous menu choices made.

From this point you can find the DoD total for any single RAG or RIC, or any combination desired. Refer to sections 3.3.2 or 3.3.3 for the discussion of “Plot Current” or “Plot Historical,” respectively.
Figure 3-51. “Mission/ICs” Menu
3.9 ANALYZE INFRASTRUCTURE CATEGORIES IN A DMC

Many Defense Mission Categories contain both mission and infrastructure-related PEs. The “ICs in a DMC” menu item allows you to separate and find one or the other of the types quickly.

Figure 3-52 shows the submenus for selecting a DMC. This is similar to the menu for “PEs in a DMC” discussed in section 3.5.

![Figure 3-52. “ICs in a DMC” Submenus](image)

3.9.1 Selecting a DMC

To find the programs in a particular DMC, first select the one-digit DMC (Major Force Missions, Defense-Wide Missions, or Defense-Wide Support Missions) then the three-digit DMC from the resulting submenus.

The menu in Figure 3-52 represents one possible selection. In this example, the analyst wants to see the data for the ICs in the Tactical Air Forces DMC. Included on the right-most submenus are the other three-digit DMCs in the “Major Force Mission” DMCs.

Selecting “Defense-Wide Missions” or “Defense-Wide Support Missions” results in a different submenu of three-digit DMCs. These are shown in Figure 3-53.
3.9.2 Selecting ICs Within the DMC

When the example choice of DMC 122 is selected, the menu shown here opens. If “Mission/IC” is selected, the list box shown in Figure 3-54 opens. Notice there are only two entries. This corresponds to the list presented when the “Mission/IC” item is chosen from the “Infrastructure Data” submenu under “Analyze.”

```
<table>
<thead>
<tr>
<th>Code</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Mission Forces</td>
</tr>
<tr>
<td>2</td>
<td>Infrastructure</td>
</tr>
</tbody>
</table>
```

Using the same example, select “Infrastructure Subcategory” to open the dialog box in Figure 3-55. This list represents the Infrastructure Subcategories within DMC 122, Tactical Air Forces.
3.9.3 Sorting, Printing, and Saving the IC List

Use the buttons at the bottom of the screen shown in Figure 3-55 to sort the list of ICs by code (IC number) or title. To print the list of ICs, click the “Print List” button. To save the list of ICs, click the “Save List” button. These functions are common to all lists of ICs.

3.9.4 Selecting ICs to Analyze

Select one or more of the ICs from the list for plotting, and use the “Plot Current” or the “Plot Historical” button. Refer to sections 3.3.2 and 3.3.3 for descriptions of the current and historical displays.
3.10 ANALYZE SERVICES

The final choice on the “Analyze” menu is “Service” as seen in Figure 3-56. This choice is a short cut to displaying the service totals only. You cannot “bore down” to the RAG or RIC level using this approach.

![Figure 3-56. “Services” Selection]

When “Services” is selected, the dialog box in Figure 3-57 is displayed.

![Figure 3-57. “Services” List]
In the DoDSPEAR model, all agencies other than SOCOM are aggregated as Defense Agency ("Def Agency").

3.10.1 Selecting a Service

Select one or more of the services from this list for plotting, and use the "Plot Current" or the "Plot Historical" button. Refer to sections 3.3.2 or 3.3.3 for descriptions of the current and historical displays.

3.10.2 Printing and Saving a Service List

To print the list of services, click the "Print List" button. To save the list of services, click the "Save List" button.
TECHNICAL INFORMATION

DIRECTORY STRUCTURE

Viewers

We recommend the following directory structure for Viewers:

Root
  — Viewers
    — FY98PB
    — FY99POM
    — FY99BES
    — etc.

The “root” directory can be the top level of any drive or may be any directory. It is highly recommended that the lower-level directory names correspond to the data kept in the directory. When updated, IDA delivers the data, usually on a CD, contained in a folder named for the updated FYDP position. These data may be copied to the host machine by dragging the entire directory folder to the host machine.

DoDSPEAR

No special directory structure is required for DoDSPEAR. We suggest that a directory named “DoDSPEAR” be created on the host machine to hold all the data files for convenience.

FILE NAMES

Viewers

The file names for Viewers are the same for each FYDP position. That is why the segregation of files by a FYDP-named directory is very useful, if not essential.
- FYDP62xx.dbf  FYDP data from FY1962 to current FYDP end year.
- CD62xx.dbf    Constant dollar TOA data from FY1962 to current FYDP end year.
- RD62xxTY.dbf  RDT&E program data from FY1962 to current FYDP end year in then-year dollars.
- RD62xxCD.dbf  RDT&E program data from FY1962 to current FYDP end year in constant dollars.
- PROCDATA.dbf  Procurement program data from FY1972 to current FYDP end year in constant dollars.
- PRTYDATA.dbf  Procurement program data from FY1972 to current FYDP end year in then-year dollars.
- DMC_DEFS.dbf  DMC definitions.
- PE_DESC.dbf   PE definitions.

Other database files in the directory are supporting files such as a list of the services, a list of infrastructure categories, and various title files. Many of the database files have associated index files.

DoDSPEAR

The many files in DoDSPEAR are named to facilitate systematic calling by the Visual Basic program. The names consist of letter codes that indicate the type of data and numbers that indicate the level of data.

- CExHISyy.dbf  This type of file includes up to 6 years of “HIS”torical data for each FYDP position at various levels of detail. The lowest level of detail, and the largest file, is CE6HIS11, data at the RIC level for each PE. As of the FY99 POM, this file contains nearly 440,000 records.

  $X = 0$  TOA only at the level indicated by “yy.”

  $X = 2$  Data at the RAG level indicated by “yy,” includes TOA, forces and personnel.

  $X = 6$  Data at the RIC level indicated by “yy,” includes TOA, forces and personnel (the two-digit RAG is combined with the four-digit RIC).

  $YY = 1$ One-digit DMC level. PE data are aggregated by DMC.
YY = 3  Three-digit DMC level.
YY = 5  Five-digit DMC level.
YY = 11 PE level. (Note: when DoDSPEAR was being
developed, there were tentative plans to increase
the number of characters in the PE code from 10
to 11. It was easier to keep the computer code
with the “11” than to rewrite the program.)

- **CExHINyy.dbf**  This type of file includes up to 6 years of “H”istorical
  “IN”frastructure data for each FYDP position at various
  levels of detail.

  X = 0  TOA only at the level indicated by “yy.”
  X = 2  Data at the RAG level indicated by “yy.”
  X = 6  Data at the RIC level indicated by “yy.”
  YY = 1  One-digit Infrastructure Code (IC) level. PE
data are aggregated by IC.
  YY = 4  Four-digit IC level.
  YY = 5  Five-digit IC level.

- **CExAPPyy.dbf**  This type of file includes 1 year of “A”ppropriated and
  expended data at various levels of detail.

  X = 0  TOA only at the level indicated by “yy.”
  X = 2  Data at the RAG level indicated by “yy.”
  X = 6  Data at the RIC level indicated by “yy.”
  YY = 1  One-digit DMC level.
  YY = 3  Three-digit DMC level.
  YY = 5  Five-digit DMC level.
  YY = 11 PE level.

- **CExAINyy.dbf**  This type of file includes 1 year of “A”ppropriated and
  expended “IN”frastructure data at various levels of detail.

  X = 0  TOA only at the level indicated by “yy.”
  X = 2  Data at the RAG level indicated by “yy.”

A-3
X = 6  Data at the RIC level indicated by “yy.”
YY = 1  One-digit Infrastructure Code level.
YY = 4  Four-digit IC level.
YY = 5  Five-digit IC level.

• DMxHINyy.dbf  This type of file includes up to 6 years of “H”istorical
  “IN”frastructure data at various levels of detail. These files
  are used for the analysis of infrastructure within a DMC.
X = 0  TOA only at the level indicated by “yy.”
X = 2  Data at the RAG level indicated by “yy.”
X = 6  Data at the RIC level indicated by “yy.”
YY = 1  One-digit Infrastructure Code level.
YY = 4  Four-digit IC level.
YY = 5  Five-digit IC level.

• DMxAINyy.dbf  This type of file includes 1 year of “A”ppropriated and
  expended “IN”frastructure data at various levels of detail.
  These files are used for the analysis of infrastructure within
  a DMC.
X = 0  TOA only at the level indicated by “yy.”
X = 2  Data at the RAG level indicated by “yy.”
X = 6  Data at the RIC level indicated by “yy.”
YY = 1  One-digit Infrastructure Code level.
YY = 4  Four-digit IC level.
YY = 5  Five-digit IC level.

• DMCyy.dbf  This type of file includes titles at various levels of detail.
YY = 1  One-digit DMC title.
YY = 3  Three-digit DMC title.
YY = 5  Five-digit DMC title.
YY = 11  PE title.
- CEx.dbf
  This type of file includes titles at various levels of detail.
  \[ X = 2 \] RAG title.
  \[ X = 6 \] RIC title.

- INFRAx.dbf
  This type of file includes titles at various levels of detail.
  \[ X = 1 \] One-digit IC title.
  \[ X = 4 \] Four-digit IC title.
  \[ X = 5 \] Five-digit IC title.

Other files in the DoDSPEAR directory provide names of the presidents, the most current position for the trend line identification, and other supporting information. Many of the database files have associated index files.

**DATA UPDATE**

**Viewers**

IDA creates new versions of the required files at each FYDP update and provides the new data folder either via floppy disk or CD to current users.

**DoDSPEAR**

IDA updates all the DoDSPEAR files at each FYDP update. The replacement files are provided via floppy disk or CD to current users.

**CODE UPDATE**

**Viewers**

If changes to the code are necessary, IDA provides an updated, compiled version of the Visual Basic code to current users.

**DoDSPEAR**

If changes to the code are necessary, IDA provides an updated, compiled version of the Visual Basic code to current users.
**FURTHER INFORMATION**

For more detailed or additional information, contact one the following individuals:

<table>
<thead>
<tr>
<th>Name</th>
<th>Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tim Graves, IDA</td>
<td>(703) 845-2339</td>
</tr>
<tr>
<td>Dave Drake, IDA</td>
<td>(703) 845-2573</td>
</tr>
</tbody>
</table>
# REPORT DOCUMENTATION PAGE

**UNCLASSIFIED**

<table>
<thead>
<tr>
<th>1. AGENCY USE ONLY (Leave blank)</th>
<th>2. REPORT DATE</th>
<th>3. REPORT TYPE AND DATES COVERED</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>4. TITLE AND SUBTITLE</th>
<th>5. FUNDING NUMBERS</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;User’s Guide to FYDP Viewers and DoDSPEAR&quot;</td>
<td>DASW01 94 C 0054</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>6. AUTHOR(S)</th>
<th>7. PERFORMING ORGANIZATION NAME(S) AND ADDRESS(ES)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timothy J. Graves</td>
<td>Institute for Defense Analyses  1801 N. Beauregard Street Alexandria, VA 22311-1772</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>8. PERFORMING ORGANIZATION REPORT NUMBER</th>
<th>10. SPONSORING/MONITORING AGENCY REPORT NUMBER</th>
</tr>
</thead>
<tbody>
<tr>
<td>T-Q7-1059</td>
<td>IDA Document D-2090</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>11. SUPPLEMENTARY NOTES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approved for public release; distribution unlimited.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>12A. DISTRIBUTION/AVAILABILITY STATEMENT</th>
<th>12B. DISTRIBUTION CODE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approved for public release; distribution unlimited.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>13. ABSTRACT (Maximum 200 words)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The FYDP Viewers and DoDSPEAR models are two tools developed to make DoD analysts’ jobs easier. The Viewers provides a simple-to-operate method of accessing Future Years Defense Program (FYDP) data, including definitions of Program Elements and Defense Mission Categories. The analytical capabilities of DoDSPEAR—named for Department of Defense Selective Program Element Analysis Report—enable analysts to isolate for further study those programs that are being planned or executed in an other-than-optimal manner.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>14. SUBJECT TERMS</th>
<th>15. NUMBER OF PAGES</th>
<th>16. PRICE CODE</th>
<th>17. SECURITY CLASSIFICATION OF REPORT</th>
<th>18. SECURITY CLASSIFICATION OF THIS PAGE</th>
<th>19. SECURITY CLASSIFICATION OF ABSTRACT</th>
<th>20. LIMITATION OF ABSTRACT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Defense Planning; Future Years Defense Program; Data Displays; FYDP Viewers; Department of Defense Selective Program Element Analysis Report (DoDSPEAR)</td>
<td>130</td>
<td></td>
<td>Unclassified</td>
<td>Unclassified</td>
<td>Unclassified</td>
<td>Unlimited</td>
</tr>
</tbody>
</table>

**Standard Form 298 (Rev. 2-89)**
Prescribed by ANSI Std. Z39-18
298-102
**UNCLASSIFIED**